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Preface
The SiRFDemo User Guide contains detailed information about how to use the 
software tool called SiRFDemo.

This User Guide is based on SiRFDemo release version 3.83, but may be relevant to 
later versions.

Who Should Use This Guide
This manual was written assuming the user has basic computer skills and is familiar 
with the Windows operating environment.

How This Guide Is Organized
Chapter 1, “Overview” gives a high-level overview of the SiRFDemo software 
product including what it does, supported products, and available menus.

Chapter 2, “Getting Started” explains how to install the software and hardware, how 
to start the SiRFdemo software, basic operation, and how to ensure that the software 
and the GPS receiver are operating correctly.

Chapter 3, “Using the SiRFDemo Software” describes SiRFdemo menu functions.

Appendix A, “SiRFDemo Real Time View Windows” lists supplimental information 
about message content in the SiRF real time view windows. 

Appendix B, “File Formats” describes the format of files that are either used by the 
SiRFDemo software or are created by the SiRFsig software.

Appendix C, “Acronyms and Abbreviations Glossary” describes all acronyms, 
abbreviations, and selected terms used in SiRF documentation..
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Troubleshooting/Contacting SiRF Technical Support
Address:

SiRF Technology Inc.  
148 East Brokaw Road 
San Jose, CA 95112 U.S.A.

SiRF Technical Support:
Phone: +1 (408) 467-0410 (9 am to 5 pm Pacific Standard Time)  
Email: support@sirf.com

General enquiries:
Phone: +1 (408) 467-0410 (9 am to 5 pm Pacific Standard Time)  
Email: gps@sirf.com

Helpful Information When Contacting SiRF Technical Support
Receiver Serial Number: __________________

Receiver Software Version: ________________

SiRFDemo Version: ____________________
viii SiRFDemo User Guide—March 2006 



Overview 1
The SiRFDemo software is a tool that provides real-time monitoring of an attached GPS 
receiver’s operation such as satellites being tracked, observed signal strength, and current 
position. It also provides the ability to configure the receiver for specific operating 
modes, as well as a data logging ability for later investigation.

See Chapter 3, “Using the SiRFDemo Software” for detailed information on the use and 
operation of the SiRFdemo software.

Supported Products
The SiRFDemo software supports multiple product lines and different software releases. 
Available features of SiRFDemo may be different, available, or not available depending 
on the GPS product being used. Supported GPS products include:

• GSW2

• SiRFXTrac

• SiRFNav

• SiRFDRive

• GSW3

• SiRFInstantFix Extended Ephemeris

By default, SiRFDemo automatically detects the SiRF GPS product being used and is 
configured accordingly.

Throughout this manual, where appropriate, the product that a particular SiRFDemo 
feature supports is indicated.

SiRFDemo Menus
The SiRFDemo software typically has six menus—seven when SiRFDRive & SiRFNav 
are selected as target software. This seventh menu is also available when SiRFDRive is 
chosen as the target software. All menus are described in Table 1-1.
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Note – The values that appear in the dialog boxes are default values and not what is 
currently set in the GPS receiver. See “Polling the Navigation Parameters” on page 3-
60 to determine the current settings of all navigation parameters.

Table 1-1 SiRFDemo Menus 

Menu Description

Setup The Setup menu lets you configure the data source used by SiRFDemo and the 
operating preferences via these menu items:
Target Software
Time
Data Source
Preferences
Software Info
See “The Setup Menu” on page 3-1 for detailed information about the Setup menu.

View The View menu lets you display different view windows. The available view 
windows include:
Signal 
Radar
Map
Navigation
Response
Output
Error
Debug
DGPS 
Geodetic Nav
PPS Timing
Auxiliary Output
SiRFDRive (available only when the selected software target is SiRFDRive or 
SiRFDRive & SiRFNav)
Ephemeris Information (available only when the selected software target is 2.3)
See “The View Menu” on page 3-5 for detailed information about the View menu.

Action The Action menu provides access to most of the SiRFDemo functionality such as 
configuration of the connected GPS receiver, data logging for later analysis, the 
extended ephemeris features. See “The Action Menu” on page 3-26 for detailed 
information about the Action menu.

Navigation The Navigation menu lets you configure items that effect how a position solution 
is acquired or the type of position needed. From the Navigation menu, you can set 
various operating masks, the DGPS mode, and the DGPS source. See “The 
Navigation Menu” on page 3-50 for detailed information about the Navigation 
menu.

Poll The Poll menu is used to obtain information about the attached GPS receiver such 
as software version, navigation parameters, and clock status. You can also use the 
Poll menu to obtain the latest ephemeris, almanac, and extended ephemeris. See 
“The Poll Menu” on page 3-58 for detailed information about the Poll menu.

Window The commands on the Window menu commands control the appearance of the 
information displayed. 

SiRFDRive The SiRFDRive menu is used to provide control of a SiRFDRive enabled product. 
This menu is only available when SiRFDRive or SiRFDRive and SiRFNav are 
selected as the target software. See “The SiRFDRive Menu” on page 3-63 for 
detailed information about the Poll menu.



Getting Started 2
This chapter describes the minimum computer requirements, installing SiRFDemo, and 
how to quickly get started using the software. See Chapter 3, “Using the SiRFDemo 
Software” for detailed information on SiRFdemo operation.

Computer Requirements
The following is the minimum computer configuration that is required to achieve 
reliable operation.

• 486 processor (or better)

• 16MB RAM minimum memory

• 100MB minimum available disk space for PC software tools installation and data 
logging

• Windows 98, NT, 2000, or XP operating system

• One available RS232 serial port 

Installing SiRFDemo
To install SiRFDemo from the provided CD:

1. Insert the CD into your CD-ROM drive.

A CD browser automatically launches and displays on the screen.

2. Select Install Software Tools from the main menu of the browser interface.

3. Select SiRFDemo.

An install shield guides you through the rest of the installation. 
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After installation is complete, a shortcut is placed on your desktop and within the 
Start / Programs menu.

To install the software tools without using the CD browser:

1. Insert the CD into your CD-ROM drive.

2. Using Windows Explorer, navigate to the folder of the software tool you want to 
install.

3. Double click on the file SETUP.EXE.

An install shield guides you through the rest of the installation.

Note – During the install process, USB driver files are copied into the SiRFDemo 
directory. These files are required when USB communication is used. Additional 
installation of the drivers are required after installing SiRFDemo.

Installing USB Drivers
SiRFDemo supports USB communication. Before USB can be used however, it is 
necessary to install the required UBS drivers. These drivers have been copied to the 
SiRFDemo directory during the installation process of SiRFDemo. The install process 
for the USB drivers is different for different operating systems.

Note – When USB is being used, the USB port is listed as an additional serial port in 
the Data Source Setup dialog.

Windows XP Installation
To install the required USB drivers on Windows 2000:

1. Connect the USB enabled SiRF GPS receiver to your PC.
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Windows opens a “Found New Hardware Wizard” window.

2. Select “Install from a list or specific location (Advanced)” and press Next.

3. Select “Include this location in the search”.

4. Press Browse to locate the directory where the drivers are located and press OK.

The drivers were copied to the SiRFDemo directory during the SiRFDemo 
installation. By default, the directory is “C:\Program 
Files\SiRF\SiRFDemo\usbDrivers”

5. Press Finish to complete the installation of the “CP2101 USB Composite Device”.

Windows now opens a second “Found New Hardware Wizard” window.

6. Repeat steps 2 through to 4.

7. Press Finish to complete the installation of the “CP2101 USB to UART Bridge 
Controller”.

Windows 2000 Installation
To install the required USB drivers on Windows 2000:

1. Connect the USB enabled SiRF GPS receiver to your PC.

Windows opens a “Found New Hardware Wizard” window.

2. Press Next to continue.

3. Select “Search for the best driver for your device (Recommended)” and press Next.

4. Select “Specify a location” and press Next.

5. Press Browse and locate the file “slabbus.inf”.

The drivers were copied to the SiRFDemo directory during the SiRFDemo 
installation. By default, the directory is “C:\Program 
Files\SiRF\SiRFDemo\usbDrivers”

6. Press Finish to complete the installation of the “CP2101 USB Composite Device”.

Windows now opens a second “Found New Hardware Wizard” window.

7. Press Next to continue and follow steps 2 through to 4.

8. Press Browse and locate the file “slabw2k.inf”.

9. The drivers were copied to the SiRFDemo directory during the SiRFDemo 
installation. By default, the directory is “C:\Program 
Files\SiRF\SiRFDemo\usbDrivers”

10. Press Finish to complete the installation of the “CP2101 USB to UART Bridge 
Controller”.

Windows 98 Installation
To install the required USB drivers on Windows 98:
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1. Connect the USB enabled SiRF GPS receiver to your PC.

Windows opens a “Found New Hardware Wizard” window.

2. Press Next to continue.

3. Select “Search for the best driver for your device (Recommended)” and press Next.

4. Select “Specify a location”.

5. Press Browse to locate the directory where the drivers are located and press Next.

The drivers were copied to the SiRFDemo directory during the SiRFDemo 
installation. By default, the directory is “C:\Program 
Files\SiRF\SiRFDemo\usbDrivers”

6. Press Finish to complete the installation of the “CP2101 USB Composite Device”.

Windows now opens a second “Found New Hardware Wizard” window.

7. Press Next to continue and follow steps 2 through to 5.

8. Press Finish to complete the installation of the “CP2101 USB to UART Bridge 
Controller”.

Connecting a GPS Receiver
To connect a SiRF GPS receiver ready for operation with SiRFDemo:

1. Connect the GPS antenna to the antenna GPS input on the GPS receiver and place 
the antenna in a location where it has a clear view of the sky. 

2. Connect one end of a serial cable to the appropriate communications port on your 
computer. 

3. Connect other end of the serial cable to Com A on the GPS receiver.

4. Connect a power supply to the GPS receiver and power it on.

Quick Start
The following provides instructions on getting SiRFDemo started and operating 
correctly with a SiRF-based GPS product.

To get started quickly:

1. Connect the GPS receiver to your PC using the provided serial cable and power on 
the receiver.

For more information about installing the GPS receiver, please see the associated 
Users Guide.
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2. Double-click on the SiRFDemo shortcut on your desktop that was created during 
the install process.

The Data Source Setup screen is displayed.

3. Select the PC serial port that is being used from the Serial Port pull down list and 
the baud rate the receiver is operating at from the Baud Rate pull down list.

Note – SiRFDemo only displays a list of available serial ports. When USB is being 
used, the USB port is listed as an additional serial port.

4. Click OK.

By default, the Signal Level, Tracking, and Map views are displayed.

5. Click the Connect/Disconnect button.
Getting Started 2-5



2

When your GPS receiver is properly connected and tracking GPS satellites, the 
Signal Level, Tracking, and Map views display information about the current 
operation of the receiver.

For detailed information about each of the views, please see “The View Menu” on 
page 3-5.

When no information is displayed on any of the screens, ensure that:

• The receiver is switched on and has a clear view of the sky.

• The serial cable is correctly connected.

• The correct serial port and baud rate are selected in the Data Source Setup dialog 
under the Setup menu.

Finally, select Synchronize Protocol & Baud Rate from the Action menu.
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Using the SiRFDemo Software 3
Before running the software, connect the SiRF GPS receiver to the PC, ensure it is 
powered on and that the antenna has a clear view of the sky. For full installation 
instructions, see Chapter 2, “Getting Started.”

To start the SiRFDemo software, either double click the sirfdemo.exe file or the 
shortcut on your desktop.

The Setup Menu
This section describes the SiRFDemo functions on the Setup menu:

• “Selecting the Target Software” on page 3-1

• “Defining the Data Source” on page 3-3

• “GPS Time / PC Time” on page 3-2

• “Changing Preferences” on page 3-4

• “Displaying Information About the SiRFDemo Software” on page 3-5

• “Exiting the SiRFDemo Software” on page 3-5

Selecting the Target Software
The SiRFDemo software supports multiple product lines and different software 
releases. These include GSW2, GSW3 SiRFNav, SiRFDRive, SiRFInstantFix 
Extended Ephemeris, and SiRFXTrac. A built-in auto-detection feature allows 

Data Source
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SiRFDemo to identify the hardware/software platform it is connected to and configure 
the dropdown menus correctly. This provides access to features that are common to 
both platforms, such as protocol, and individual access and definition to features that 
are either unique, such as Static Navigation, or redefined, such as TricklePower, for 
each platform. 

Once connected, SiRFDemo attempts to identify the connected product and software 
release. When the hardware detection function fails, you are prompted to select the 
target software manually. The auto-detection function can be disabled by unchecking 
the Auto-detection checkbox.

To select the target software type:

1. Select Target S/W from the Setup menu.

The Select Target Software dialog is displayed.

2. Select the appropriate target software.

3. Uncheck the Auto-detection checkbox to disable the auto-detection function or when 
the auto-detection fails.

4. Click OK to accept the selection.

GPS Time / PC Time
The SiRFDemo software is capable of matching GPS clock time to PC time. When the 
difference between GPS time and PC is greater than two seconds, PC clock is set to 
match GPS time.

To select GPS Time / PC Time:

1. Select GPS Time / PC Time from the Setup menu.
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The Setup menu is displayed.

When a checkmark appears next to GPS Time, the clocks are matched.

Defining the Data Source
The SiRFDemo software is capable of receiving data from different sources. You can 
configure SiRFDemo to receive data directly from a connected GPS receiver, generate 
its own random data, or load data from a previously logged file.

To configure the source of the data used by the SiRFDemo software:

1. Click the Data Source button or select Data Source from the Setup menu.

The Data Source Setup screen is displayed.

2. Select either the Serial Port, File, or Random as the required data source. The 
following table provides a description of each available option:

Note – SiRFDemo only displays a list of available serial ports. When USB is being 
used, the USB port is listed as an additional serial port.

Option Description

Serial Port SiRFDemo uses data directly from a connected GPS receiver. The connected 
communication port and the used Baud rate must be selected.

File SiRFDemo uses data that is contained within an existing data file. The file may 
contain data in either SiRF Binary or NMEA formats.

Random SiRFDemo uses randomly generated data. Use this option to verify that the 
SiRFDemo software is running without any receiver connected.

Aux Data 
Source

Provided for SiRFDRive use only, SiRFDemo can be configured to receive 
external data from another source other than the GPS receiver.
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3. Click OK to accept selected settings. 

Changing Preferences
You can change the appearance of some of the view windows to suit your personal 
preferences. View preferences include the Signal Level view, the Tracking view, and 
the Map view.

To change the appearance of the view windows:

1. Select Preferences from the Setup menu.

The Preferences screen is displayed.

2. Select the type of signal graph that you want to view on the 12-Channel Signal 
Level View screen.

3. Select the direction of the tracking orientation that you want to use in the Tracking 
View screen. 

4. To change the scale of the Map view, enter the number of meters you want each 
pixel to represent in the Meters Per Pixel field.

5. Click Save to save the changes or Cancel to exit without saving changes.

Option Description

Bar Displays the data with vertical bars to represent the observed signal strength 
of each satellite.

Line Displays the data in a continuous line graph form.

Option Description

North Up True north points to the top of the circle.

Heading Up This is typically used when the board is moved by simulation. Again, it is not 
recommended to use the board in a vehicle. Current heading points to the top 
of the circle.
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Displaying Information About the SiRFDemo Software
1. Select About SiRFDemo from the Setup menu to display SiRFDemo software 

information:

Exiting the SiRFDemo Software
1. Select Exit from the Setup dropdown menu.

This closes SiRFDemo software.

The View Menu
This section describes the SiRFDemo functions on the View menu:

• “The 12-Channel Signal Level View Screen” on page 3-6

• “The Radar View Screen” on page 3-8

• “The Map View Screen” on page 3-10

• “The Navigation Message View Screen” on page 3-12

• “The Response View Screen” on page 3-13

• “The Output View Screen” on page 3-13

• “The Error Message View Screen” on page 3-14

• “The Debug Data View Screen” on page 3-14

Signal Level

Tracking
Map
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• “The DGPS View Screen” on page 3-15

• “The Geodetic Nav View Screen” on page 3-16

• “The PPS Timing View Screen” on page 3-18

• “Aux Serial Port Message Forwarding” on page 3-19

• “SiRFDrive View Screen” on page 3-20

• “Ephemeris Information” on page 3-24

The 12-Channel Signal Level View Screen
The 12-Channel Signal Level View screen is a combined graphical and text display of 
satellite tracking. Information shown by the Signal Level view includes satellite 
number, status, azimuth, elevation, C/No, and last five seconds of measured signal 
strength.

To display the 12-Channel Signal Level view screen:

1. Click the Signal Level View button or select Signal Level from the View menu.

Note – The Preferences screen allows you to modify the way information is displayed. 
Double-click the 12-Channel Signal Level View screen to display the Preferences 
screen.  

Table 3-1 12-Channel Signal Level View Information

Information Displayed Description

Satellite Number (SV) The GPS satellite PRN number.

Status (St) The status of each satellite tracked (see Table 3-2, “Tracking Status 
Definitions,” on page 3-7 for more information).

Azimuth (Az) Satellite azimuth (in degrees).
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Table 3-2 represents each of the possible tracking status messages and the 
corresponding tracking status. Each tracking status state corresponds with an achieved 
tracking stage for each channel of the GPS receiver. 

For example, when a tracking status of 33 (Hex) is displayed, this means that satellite 
acquisition is achieved, the delta-phase is valid, the carrier pull-in is complete, and the 
code is locked onto. From a cold start you typically see the following sequence of 
tracking status changes; 00 33 37 3F BF. It only takes about one second to 
achieve a 37 status, approximately another 12 seconds to get to a 3F status, and finally 
another 20 seconds to achieve a BF status. The sequence and time frames may vary 
considerably between channels and sessions.

Elevation (El) Satellite elevation (in degrees) with the horizon being zero degrees 
in elevation, and directly over-head being ninety degrees.

C/No Signal level (in dB-Hz).

Signal Level (-5 sec) Five-second history of the measured signal strength.

Table 3-2 Tracking Status Definitions  
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Table 3-1 12-Channel Signal Level View Information

Information Displayed Description
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See “Navigation Library SV State Data - Message ID 30” in the SiRF Binary Reference 
Manual for information about SiRF extended ephemeris tracking status messages.

The information displayed in the Signal Level view is also assisted by color coding. As 
the tracking status of each satellite changes, the associated text and signal levels are 
colored to represent the current status (see Table 3-3).

The Radar View Screen
The Radar View screen graphically displays the location of each of the tracked, used, 
and available satellites in the form of a polar plot.

To display the Radar View screen:

AD

AF

BF

40

CC

CD

Table 3-3 12-Channel Signal Level View Color Coding

Color Description

Red The satellite location is known from almanac information; however, the satellite is 
not currently being tracked.

Blue The satellite is being tracked; however, it is not being used in the current position 
solution.

Green The satellite is being tracked and is being used in the current position solution.

Aqua For SBAS satellites only. The satellite is being tracked and corrections are being 
used in the current position.

Magenta The satellite is being tracked; however, a SiRFInstantFix extended ephemeris is 
being used for the position solution.

Table 3-2 Tracking Status Definitions  (continued)

Achieved Tracking Stage
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1. click the Radar View button or select Radar from the View menu.

In addition to the satellite locations, the current tracking status is represented by color 
(see Table 3-4).

Current speed and heading (in a dynamic environment such as a moving vehicle) is 
represented by an arrow. The direction of the arrow represents heading while the 
length of the arrow indicates speed over ground.

Table 3-4 Tracking View Color Coding

Color Description

Red The satellite location is know from almanac information; however, the satellite is 
not currently being tracked.

Blue The satellite is being tracked; however, it is not being used in the current position 
solution.

Green The satellite is being tracked and is being used in the current position solution.

Aqua For SBAS satellites only. The satellite is being tracked and corrections are being 
used in the current position.

Magenta .The satellite is being tracked; however, a SiRFInstantFix extended ephemeris is 
being used for the position solution.
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Configuring the Radar View Screen
The Radar view screen orientation and velocity representation can be configured.

To configure the Radar view screen:

1. Double click the Radar View screen to display the Tracking View Configuration 
screen.

2. Select the direction of the tracking orientation that you want to use. 

3. Enter the Outer circle velocity (in m/sec).

Note – The setting of the outer circle velocity means that when the arrow length 
reaches the outer circle of the plot, then the outer circle velocity has been reached.

4. Click OK to save the changes or Cancel to exit without saving changes. 

The Map View Screen
The Map view screen displays a combination of graphical and text-based information. 
Positions generated by the GPS receiver are plotted on the Map view screen while 
other information such as GPS time, GPS week, position mode, current position, 
heading, velocity, DOP, type of position fix, and satellites tracked are displayed as text.

To display the Map view screen:

Option Description

North Up True north points to the top of the circle.

Heading Up This option can be used when driving. Current heading points to the top of 
the circle.
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1. Click the Map View button or select Map from the View menu.

The Map View screen is displayed.

The current position is represented on the plot by a red dot, while past positions are 
displayed in blue.

2. Click Clear at any time to clear any plotted positions on the plot.

3. Click Current as Origin to make the origin of the plot the same as the most recent 
plotted position.

Note – When using the map view, you may want to change the way it is displayed. To 
edit display preferences, see “Changing the Map View Preferences” on page 3-11.

Changing the Map View Preferences
The ability to change the scale of the Map view and the origin of the map is provided 
by the Map view preferences.

To change the Map view preferences:

1. Double click the Map View screen to display the Preferences window.
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2. Enter the number of meters you want each pixel to represent in the meters/pixel 
field. This value controls the map scale.

3. Enter the latitude and longitude (in WGS-84) of the required center of the Map 
View display in the Lat and Lon fields.

4. To display up to three rings on the MapView display, enter the radius (in meters) of 
each of the rings in the Ring Radii group.

When a value of zero is entered, the ring is not be displayed.

5. Click Save to save the changes or Cancel to exit. 

The Navigation Message View Screen
The Navigation Message view screen is used to display position solution information 
such as GPS time, GPS week, position mode, current position, heading, velocity, DOP, 
type of position fix, and satellites tracked.

To view the Navigation Message View screen:

1. Select Navigation Message from the View menu.

The Navigation Message View screen is displayed.   

Table 3-5 Navigation Message View Information  

Information 
Displayed Description

X, Y, Z positions Coordinates of user’s position in ECEF (meters)

Velocity User’s velocity in ECEF (m/sec)

Latitude User’s latitude (decimal of degrees)

Longitude User’s longitude (decimal of degrees)

Altitude User’s altitude (meters)

Heading .GPS product’s direction.

Mode 1 Navigation solution type. This changes from a No Nav status, through the 
different fix modes such as 2D, 3DLSQ etc. The Mode field should be used 
for any TTFF measurements

GPS Week GPS week number
3-12 SiRFDemo User Guide—March 2006 



3

Note – ECEF XYZ is converted geodetic latitude, longitude, and altitude based on the 
WGS84 ellipsoid parameters. 

The Response View Screen
The Response View screen is used to display any response to a poll request. You can 
poll the GPS receiver for the software version (see ““Polling the Extended Ephemeris” 
on page 3-62” on page 3-58), clock status (see “Polling the Clock Status” on page 3-
59), navigation parameters (see “Polling the Navigation Parameters” on page 3-60), 
ephemeris state (see “Polling the Ephemeris State” on page 3-62), and gyro calibration 
verification (see “Polling Gyro Factory Calibration” on page 3-65). 

To display the Response View screen:

1. Select Messages Response from the View menu

The Response View screen is displayed.

The Output View Screen
The Output View screen is used to display the SiRF Binary message IDs that are 
currently being output by the attached GPS receiver.

To display the Output View screen:

1. Select Messages Output from the View menu.

DOP Dilution of Precision

Fix 2 Validated/unvalidated. From an unvalidated state, a five SV position solution 
must be achieved to become a validated position. If the board continues to 
navigate in a degraded mode (3D, 2D, 1SV, or DR), then the validated status 
remains. When navigation is lost completely, an unvalidated status results.

Time Current GPS time (seconds)

SVs Used in Fix SV PRN used in solution

Time To First Fix The TTFF value is cleared any time a no-nav position is reported (msg 2), so 
the TTFF field is automatically cleared when a reset command is sent

1. The Mode field is mapped to SiRF Binary Protocol MID2, mode 1 (see the SiRF Binary Reference Manual). The mode field 
should be used as the TTFF indicator and not the Fix field with any non-zero value of mode 1 indicating a usable navigation solution.

2. The Fix field is mapped to SiRF Binary Protocol MID2, mode 2 (see the SiRF Binary Reference Manual).

Table 3-5 Navigation Message View Information  (continued)

Information 
Displayed Description
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The Receiver Output View screen is displayed.  

The Error Message View Screen
The Error Message View screen is used to display any error messages that the GPS 
receiver may generate. Error messages are generated automatically by the GPS 
receiver under certain conditions. Many are caused by normal GPS operations such as 
acquiring a low elevation satellite, which could result in a bad parity.

To view the Error Message View screen:

1. Select Messages Error from the View menu.

The Error Messages View screen is displayed.

The Debug Data View Screen
The Debug Data View screen displays additional information about the GPS receiver 
operation. The data is generated automatically by the GPS receiver.

To view the Debug Data View screen:

1. Select Messages | Debug from the View menu.
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Note – To view incoming debug data the Enable Debug Data checkbox must be 
enabled on the Receiver Initialization screen. See “Initializing the Data Source” on 
page 3-31.

The DGPS View Screen
Depending on the target software, choices of DGPS operation include SBAS, external 
RTCM or Internal DGPS Beacon. See “Selecting the DGPS Source” on page 3-56 for 
more information about each of these options. The DGPS View provides information 
about the DGPS source and current operation.

To view the DGPS View screen:

1. Select Messages | DGPS from the View menu.

The DGPS View screen is displayed.
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The following table provides a description of each of the displayed items:

The Geodetic Nav View Screen
The Geodetic Nav View screen provides data about the current navigation and position 
performance.

To view the Geodetic Nav View screen:

1. Select Messages | Geodetic Nav from the View menu.

Information Description

Source Displays the source of the current DGPS corrections.

GPS Corrections Displays the PRN, pseudo-range correction received, and the age of the 
correction for each satellite.

Internal DGPS 
Beacon Receiver

Displays where the correction was received from. The possible sources 
are external RTCM, internal beacon, and WAAS.
For example, when the internal beacon (see footnote) is the DGPS source, 
the following information is displayed:

Locked: Status of tracking Coast Guard Beacon
Frequency: Frequency (KHz) of beacon tracked
Bit Rate: Bits per second (bps) for signal demodulation
Signal Magnitude: Variable
Signal Strength: Variable
SNR: Signal to Noise Ratio (TBD)

SBAS Displays information about the current SBAS operation if used. The 
information includes:

PRN: The unique SBAS satellite identifier
Mode: Testing or Integrity monitored.
Timeout: The time out of SBAS corrections
Health: Health status of the SBAS corrections
Correction: SBAS correction
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The Geodetic Nav View screen is displayed.

The following table provides a description of each of the displayed items:

Table 3-6 Geodetic Nav View Screen Displayed Items  

Information Description

Nav Validity Provides navigation validity. When the navigation solution is not 
valid, the reason for this are displayed

Nav Mode The current mode of the navigation solution

GPS Wk The GPS Week

TOW Time of Week (in seconds)

UTC UTC time

SVs in Fix The number of satellites currently used in the navigation solution

Lat The current calculated latitude (in degrees)

Lon The current calculated longitude (in degrees)

Alt (ellip) The altitude above the ellipsoid (in meters)

Alt (msl) The altitude above mean sea level (in meters)

Map Datum The currently used map datum

HDOP Horizontal Dilution of Precision

SOG Speed Over Ground (in meters/second)
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The PPS Timing View Screen
The PPS Timing View screen reports the UTC time of the 1 PPS pulse whenever it has 
a current status from the satellites. When the board does not have a valid UTC status, 
it reports GPS time which is indicated by a status flag. 

To display the PPS Timing View screen:

1. Select Messages PPS Timing from the View menu.

Heading Direction of movement

COG Course Over Ground (in degrees)

Hdg Error The current heading error (in degrees)

Mag Var The currently used magnetic variation (in degrees)

Clmb Rte The change in altitude over time (in meters/second)

Hdg Rte The change in heading over time (in degrees/second)

EHPE Estimated Horizontal Position Error (in meters)

EVPE Estimated Vertical Position Error (in meters)

ETE Estimated Time Error (in meters)

EHVE Estimated Horizontal Velocity Error (in meters/second)

Clk Bias / Error The current clock bias and error (in meters)

Clk Drft / Error The current clock drift and error (in meters/second, error in meters)

Traveled / Error The distance travelled since reset and the associated error (in meters)

DR Direction When using the SiRFDrive software tool, the dead reckoning sensor 
detects forward or reverse speed 

Map Matching Feedback 
Input

N/A indicates product does not support map matching
Flags indicate enabled/disabled or true/false map matching

Map Matching Feedback 
Rcvd.

N/A indicates product does not support map matching
Flags indicate enabled/disabled or true/false map matching

Map Matching Feedback 
Used in Solution

N/A indicates product does not support map matching
Flags indicate enabled/disabled or true/false map matching

Table 3-6 Geodetic Nav View Screen Displayed Items  (continued)

Information Description
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The PPS Timing View screen is displayed.

The following table provides a description of each of the displayed items:

Aux Serial Port Message Forwarding
When both the Main and Aux serial ports are open, some SiRF Binary messages 
received on one port are forwarded to the other port. 

To use the auxiliary data source: 

1. Select Data Source from the Setup menu.

The Data Source Setup screen is displayed.

2. Check the Use Aux Data Source checkbox.

• Any SiRF Binary message received on the Aux port is sent to the Main port and 
logged in the .gps log file as CLM->GPS.

Information Description

Time (hh:mm:ss) The time of the 1 PPS pulse

Date (dd/mm/yyyy) The date of the 1 PPS pulse

UTC Offset (sec) The time offset from UTC

Time is valid? (true/false) The validity of the displayed time

GPS Time or UTC Time The time type being displayed

UTC to GPS time info is current? 
(true/false)

An indication of whether the information to convert from 
GPS to UTC time is valid
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• When SiRF Binary msg 0x38 or 0xE8 is received on the Main serial port, it is 
forwarded to the Aux port and logged in the .gps log file as GPS->CLM.

TCP instead of Serial Port Option
The main data source can be configured as a TCP/IP connection instead of a serial 
port. This is useful when the test setup is SD<->CLM<->Rx, and the connection 
between the CLM and Rx is a physical serial port, while the SD to CLM connection is 
TCP.  

To do this, select TCP:7555 from the Aux Data Source Port dropdown menu.

The number 7555 is the port that is used on your local host machine (IP=127.0.0.1), in 
this case 7555 is the default port for the CLM test app.

Note that the log file contains two new messages when logging TCP data:

• Any data sent is logged as TCPx: 0xA0A2… instead of Tx: 0xA0A2…

• When TCP data is received a ‘TCP data len=’ message is logged showing the 
number of bytes received over TCP.

SiRFDrive View Screen
The SiRFDRive view is only available when the software SiRFDRive is selected as the 
target software. The SiRFDRive View screen provides the DR navigation status and 
DR sensor data. The screen is divided into the following fields: 

• DR Navigation Status

• DR Navigation State

• DR Subsystem Data

• DR Data Block

To view the SiRFDRive View screen:

1. Select Messages | SiRFDRive from the View menu.
3-20 SiRFDemo User Guide—March 2006 



3

The SiRFDRive View screen is displayed.

DR NAV STATUS
The following table provides a description of each of the displayed items for the DR 
NAV STATUS field.

Table 3-7 NAV STATUS Field Items  

Item Description

DR Nav Status of the DR navigation solution

DR Data Status of the DR data being generated

DR Cal Calibration status of the DR sensors

DR Gyr Bias Cal Calibration status specifically for gyro bias

DR Gyr SF Cal Calibration status specifically for gyro scale factor

DR Spd SF Cal Calibration status specifically for the speed sensor scale factor

DR Nav across Reset Conditions are appropriate to do a DR navigation after a system reset 
or power cycle

DR Pos DR position status

DR Hdg DR heading status

DR Gyr Subsys Op Operational status of the gyro heading sensor

DR Spd Subsys Op Operational status of the speed sensor

DR Nav St Int Ran The DR navigation algorithm integrate the raw DR data
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Note – When the status is invalid, one or more of the bits appears in upper-case.

DR NAV STATE
The following table provides a description of each of the displayed items for the 
DR NAV STATE field.

0-Spd GB Cal Upd System has performed the special bias calibration that is done when 
the vehicle is stationary

DR GBSF Cal Upd Status of whether the gyro bias scale factor updated during the cycle

DR Spd Cal Upd Status of whether the speed sensor calibration updated during the cycle

DR Upd Nav State Indicates whether the DR has updated the navigation state

Gps Upd Pos The GPS solution updated the navigation position during the cycle

Gps Upd Hdg The GPS solution updated the heading during the cycle

Gps Pos for DR GPS position valid for DR

GPS Vel for DR GPS velocity valid for DR

Item Description

DR Spd The speed computed from the DR portion of the solution (in 
meters/second)

DR Spd Error Error in the DR speed (in meters/second)

DR Spd SF Scale factor of the speed calibration

DR Spd SF Error Error in the DR speed scale factor

DR Hdg Rte The change in heading computed from the DR portion of the solution (in 
degrees/second)

DR Hdg Rte Error Error in the DR heading rate (in degrees/second)

DR Gyr Bias The bias or offset in the gyro heading sensor output (in degrees/second)

DR Gyr Bias Error Error in the DR gyro bias (in degrees/second)

DR Gyr SF Scale factor of DR gyro heading sensor scale factor calibration

DR Gyr SF Error Error in the DR gyro scale factor calibration

DR Hdg DR sensor heading (in degrees)

DR Hdg Error Error in the DR heading based on the combined navigation solution (in 
degrees)

Total DR Pos Error Error in the last DR position (in meters)

Dir Forward or reverse direction based on the reverse input signal

Nav Ctrl The DR mode that is selected

Table 3-7 NAV STATUS Field Items  (continued)

Item Description
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DR NAV SUBSYSTEM DATA
The following table provides a description of each of the displayed items for the 
DR NAV SUBSYSTEM DATA field.

DR DATA BLOCK
The following table provides a description of each of the displayed items for the 
DR DATA BLOCK field.

Item Description

Gps Hdg Rte Rate of change in heading based on GPS solutions (in degrees/second)

Gps Hdg Rte Error Estimated error of the GPS heading rate (in degrees/second)

Gps Hdg (T) Heading from true north based on GPS solutions (in degrees)

Gps Hdg (T) Error Estimated error of the GPS heading (in degrees)

Gps Spd Speed over ground based on GPS solutions (in meters/second)

Gps Spd Error Estimated error of the GPS speed (in meters/second)

Gps Pos Error Estimated error of the last GPS position (in meters)

DR Hdg Rte Rate of change in heading based on DR sensor solutions (in 
degrees/second)

DR Hdg Rte Error Estimated error of DR sensor heading rate (in degrees/second)

DR Hdg (T) Heading from true north based on DR sensors (in degrees)

DR Hdg (T) Error Estimated error of DR sensor (in degrees)

DR Spd Speed over ground based on DR sensor solutions (in meters/second)

DR Spd Error Estimated error of DR sensor speed (in meters/second)

DR Pos Error Estimated error of the last DR position solution (in meters)

Item Description

Meas Type Measurement type

# of Valid Number of valid DR sensor measurements from the last block of 10 
measurements

Backup Flags The state of the reverse signal for the corresponding data set

Time Time of each measurement (in milliseconds)

DR Spd Speed measured from the DR sensor (in meters/second)

Gyr Hdg Rte Raw heading rate from the gyro (in degrees/second)
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Ephemeris Information
The Ephemeris Info View is only available when 3.2 is selected as the target software 
in the Setup menu. 

To view the Ephemeris Info View screen:

1. Select Messages | Ephemeris Info from the View menu.

The Ephemeris Info View screen is displayed.  

There are four sections in the Ephemeris View window:

1. The first section displays the message: Status: Disable Broadcast Eph ACK rcvd. 
when the disable broadcast eph message is received while the Ephemeris Info 
window is open. Otherwise this section displays Status. 
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• Disable sends msg 0xE8, subID 0xFF, with debug flags data = 0x01000000 (this is 
the same as selecting Action/Disable Broadcast Eph from the dropdown menus). 

• Clear resets the display message to Disable Broadcast Eph. 

• When the checkbox Send Disable Broadcast Eph every 1 second until Ack is Rcvd 
is checked, then SiRFDemo sends the disable broadcast eph msg every 1 second 
until the ack is received from the receiver, at which time the disable broadcast eph 
every second checkbox becomes unchecked.

2. The second section displays the contents of the client’s T-message (request for 
ephemeris from the CLM). When a T-message is received in SiRFDemo, it records 
the PC time of the event and shows a timer indicating the time elapsed since the last 
T-message was received. Clear clears the display for this section of the window.

3. The Eph field from msg 30 for each SV that is reported. This section only updates 
when the receiver’s NavLib output is enabled. To enable NavLib output, send a 
snap start with the nav lib option checked. Clear clears the display for this section 
of the window.

4. The response messages to a poll ephemeris state message are shown in a table of 
SVIDs vs 5 fields; ephemeris flag, eph week num, TOE (time of week in 16 second 
increments), Integrity of ephemeris, and Age (if an extended ephemeris is used). 

Poll sends SiRF Binary msg 0xE8, subId 0x02 with SvMask= 0xFFFFFFFF, which 
requests the ephemeris state for all SVs, 1-32. 

Note – Poll has the same effect as selecting Poll | Ephemeris State. Clear clears the 
display for this section of the window.

Note – The response messages fields may contain either broadcast ephemeris data or 
extended ephemeris data.
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The Action Menu
This section describes the SiRFDemo functions on the Action menu: 

• “Opening a Data Source” on page 3-27

• “Opening a Log File” on page 3-27

• “Adding Text to a Log File” on page 3-30

• “Pausing the Display” on page 3-30

• “Initializing the Data Source” on page 3-31

• “Switching to the NMEA Protocol” on page 3-36

• “Switching to the SiRF Protocol” on page 3-37

• “Synchronizing Protocol and Baud Rate” on page 3-37

• “Switching to User1 Protocol” on page 3-38

• “Setting the Main Serial Port” on page 3-38

• “Setting the DGPS Serial Port Parameters” on page 3-38

• “Setting the UART Configuration” on page 3-39

• “Uploading an Almanac to a GPS Receiver” on page 3-41

• “Uploading an Ephemeris to a GPS Receiver” on page 3-41

• “Opening an Extended Ephemeris File” on page 3-42

Open Data Source (not connected)

Open Data Source (connected)

Open Log File

Pause Display

Initialize Data Source
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• “Switching Operating Mode” on page 3-43

• “Disabling a Broadcast Ephemeris” on page 3-44

• “Setting Low Power Parameters” on page 3-45

• “Setting Advanced Power Management Options for SiRFXTrac” on page 3-48

• “Setting the Message Rate” on page 3-48

• “Transmitting a User Defined Serial Message” on page 3-49

Note – All values that appear in the dialog boxes under this menu are default values 
only. To determine the current settings of all navigation parameters, refer to Section , 
“Polling the Navigation Parameters,” on page 60.

Opening a Data Source
Before any data can be received from or sent to a GPS receiver a communications 
channel must be established or a data source must be opened.

To open a data source:

1. Click the Connect/Disconnect button or select Open Data Source from the Action 
menu.

2. Click the Connect/Disconnect button again or select Open Data Source from the 
Action menu to disconnect communication to the GPS receiver. 

Opening a Log File
The log file function provides the ability to log selected information from a connected 
GPS receiver and store it to a file.

To open a file and select messages to log:

1. Click the Log File Settings button or select Open Log File from the Action menu.
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The Log File Settings window is displayed.

2. Select each message you want to log to a file by clicking the required message. 
Select all of the messages at once by clicking Select All.

Note – Only records that are selected are logged to a file. When logging all available 
messages, use 38400 Baud or higher. This ensures that no data is lost during logging.

3. Check the Record Log File Only During a Specified Time Interval checkbox to 
designate a particular logging interval and enter the start time, stop time, and date.

4. Check the Record Log File Only During a Specified Time Interval checkbox and enter 
in the Duration field a particular duration (in seconds) after which the logging 
session is closed. 

5. Click OK to begin logging the selected messages or Cancel to abort opening a file.

During logging, logging status is displayed at the bottom of the SiRFDemo screen.
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Each of the available message types and a brief description is provided in Table 3-8.  

Table 3-8 Messages That Can Be Logged to a File  

Messages Description

001 Ref Nav (undefined) Reference Navigation

002 Measured Navigation Time, position, velocity,...

004 Measured Tracking Satellite status and C/No

005 Raw Track Data Not supported by SiRFstarII

006 SW Version Software version of the connected GPS receiver

007 Clock Status Board clock performance

008 50 BPS Subframe Data Satellite ephemeris and almanac data

009 Throughput CPU throughput usage

010 Error Various error messages

011 Command Ack Acknowledgment of received commands

012 Command Nak Input message failures

013 Visible List Satellite visibility list (based on current almanac)

014 Almanac Satellite almanac data

015 Ephemeris Satellite ephemeris data

017 Raw DGPS Differential GPS corrections in RTCM format 

019 Rcvr Params Parameters affecting navigation solutions

027 DGPS Status Status of differential GPS correction

028 Nav Lib: Meas Observed satellite measurement data

029 Nav Lib: DGPS Received differential GPS correction information

030 Nav Lib: SV State Observed velocity, position and clock information

031 Nav Lib: Init Startup initialization information

041 Geodetic Nav Navigation data

045 ADC / ODO Analog Digital Converter / Odometer

046 Test Mode Diagnostic mode

048 SiRFDRive SiRFDRive data

050 SBAS Status SBAS operation data

052 PPS Timing Time information for the 1 PPS output

055 Test Mode 4 Trk Data Diagnostic mode

056 SEA Output SiRF extended ephemeris output message

172 Wheeltick SiRFDrive dead reckoning
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Adding Text to a Log File
During logging of data, it is possible to place a text entry into the file during logging. 

Note – The Put Text Into Log File option is only available while a log file is being 
collected.

To add a text entry into the current log file:

1. Select Put Text Into Log File from the Action menu.

The Enter Text Message To Insert Into Log File screen is displayed.

2. Enter the text to be placed into the text file.

3. Click OK.

The log file is annotated with a line displayed the following format:

“User Text: hh:mm:ss <entered text>”

Pausing the Display
All of the open windows can be paused to allow easy viewing of the existing data 
without receiving any further data.

To pause all of the open windows:

1. Click the Pause button or select Pause Display from the Action menu.

Note – No data is logged while the display is paused.

225 Stats Channel Reports stats about startup time and encrypted messages

232 SEA Input SiRF extended ephemeris input message

255 Debug Various development information

Table 3-8 Messages That Can Be Logged to a File (continued) 

Messages Description
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Initializing the Data Source
You can reset or initialize a connected GPS receiver directly through the SiRFDemo 
software. This function may be used to demonstrate or evaluate a product’s recovery 
ability under different circumstances.

The Receiver Initialization screen offers additional features depending on which target 
is selected in the Setup | Target SW menu.

When SiRFDrive is selected in Setup | Target SW menu, see “Initializing SiRFDRive 
Navigation Parameters” on page 3-34.

When SiRFXTrac, 3.0&3.1, or 3.2, is selected in Setup | Target SW, see “Initializing 
SiRFXTrac, 3.0&3.1, and 3.2 Navigation Parameters” on page 3-35. 

To perform a reset or allow Nav Lib or Development data to be output from a receiver:

1. Click the reset button or select Initialize Data Source from the Action menu.

The Receiver Initialization screen is displayed.
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2. Select type of Reset Mode by clicking the associated radio button. 

Note – When Cold start is selected, all GPS receiver settings are reset to factory 
defaults with the exception of low power settings.

3. When you selected the Warm Start (Init) reset mode, enter or load the X, Y, and Z 
coordinates for the current position of the GPS receiver. 

4. Load a file containing the X, Y, Z coordinates by clicking Load. 

The Specify a Name for the Position File window is displayed.

5. Select the sample sirf.pos configuration file.

Option Description

Snap Start The GPS receiver restarts by using the values stored in the internal memory of 
the GPS receiver. The following validated parameters are used: time, position, 
almanac, and ephemeris.

Hot Start The GPS receiver restarts by using the values stored in the internal memory of 
the GPS receiver; validated ephemeris and almanac.

Warm Start 
(No Init)

This option has the same functionality as Hot Start except that it clears the 
ephemeris data and retains all other data.

Warm Start 
(Init)

This option clears all initialization data in the GPS receiver and subsequently 
reloads the data that is currently displayed in the Receiver Initialization Setup 
screen. The almanac is retained but the ephemeris is cleared. 

Cold Start This option clears all data that is currently stored in the internal memory of 
the GPS receiver including position, almanac, ephemeris, and time. The stored 
clock drift however, is retained.

Factory Start This option clears all data including position, almanac, ephemeris, time, as 
well as the stored clock drift. All GPS receiver parameters are also set back to 
the factory defaults.
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Note – An example file called sirf.pos is provided with the SiRFDemo software. 
See “Modifying the Sample sirf.pos File” on page B-1 for more information on 
creating a valid .pos file.

6. Click Open. The Receiver Initialization screen is displayed again.

7. Enter 96,000 in the Clock field (96,000 is a typical clock drift value of the crystal 
in the GPS receiver).

Note – When you enter zero in the Clock field, the GPS receiver uses its last stored 
value, or a default of 96,000 when no prior stored value is available.

8. Click on or off the Use current PC time checkbox. 

Note – It is recommended that you use PC time (it is assumed that the date and time on 
your computer are set correctly).

9. When you select Use current PC time, enter the UTC offset for your location in the 
UTC offset field.

10. When you do not select Use current PC time, enter the number of the week and the 
time of the week in the corresponding fields.

11. Enter the number of channels in the Channel field.

You can specify from 1 to 12 channels.

12. Check Enable Nav Lib Data to log navigation library data.

13. Check Enable Development Data to turn on message 255. 

The content of this message is displayed in the Development Data View. The Baud 
rate of the SiRFDemo software and the attached GPS receiver is automatically 
changed to 57600 to ensure sufficient through-put to accommodate the quantity of 
data.

Note – The Development Data output by a GPS receiver is required to assist in the 
analysis and debug of system performance problems. It is highly recommended to 
enable Development Data during development and testing in the event that support is 
needed from SiRF. 

14. Enter a periodic reset value in the Periodic Reset field to automatically reset the 
board at the defined interval. 

Valid values are 5 to 600 seconds. A value of zero cancels the periodic reset 
function.

15. Check Clear User Data in Battery-Backed RAM to force user defined data to be reset 
to their default values 

16. Click Send to initialize or Cancel to exit.
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When SiRFNav & SiRFDRive is selected as the target software, the SiRFDRive 
Navigation Initialization option is available instead of Receiver Initialization.

You can reset or initialize a GPS receiver directly through the SiRFDemo software. 
This function may be used to demonstrate or evaluate the Board’s recovery ability 
under different circumstances.

The SiRFDrive Navigation Initialization enables you to specify location and heading 
after a Warm /w Init reset. This data aids in acquiring the first fix.

Initializing SiRFDRive Navigation Parameters
1. Click the reset button or select SiRFDRive | Navigation Initialization from the 

Navigation menu. 

The SiRFDRive Navigation Initialization screen is displayed.

Select type of Reset mode by clicking the associated radio button. The following table 
describes the reset types.

Table 3-9 Reset Options  

Reset Mode Description

Hot GPS receiver restarts by using values stored in internal memory of the board. 
The stored ephemeris and almanac are valid.

Warm Same functionality as Hot Start except that it clears the ephemeris data and 
retains all other data.
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2. When selecting Warm (w/Init) reset mode, enter the Latitude, Longitude, Altitude, 
and Heading for the current position of the GPS receiver.

3. Click Send to send the command.

Initializing SiRFXTrac, 3.0&3.1, and 3.2 Navigation Parameters
When SiRFXTrac, 3.0&3.1, or 3.2 are selected from the Setup | SW menu, the 
Receiver Initialization screen offers the additional options described below.  

Select a Reset option by clicking the associated radio button. The following table 
describes the additional reset options available when SiRFXTrac, 3.0&3.1, or 3.2 are 
selected from the Setup | SW menu.

Warm (w/Init) Clears all initialization data in the board and updates the data that is entered in 
the Initialization screen. The almanac is retained but the ephemeris is cleared.

Cold Clears all data that is currently stored in the internal memory of the board, 
including position, almanac, ephemeris, and time. The stored clock drift is 
retained.

Factory Reset Clears all data including position, almanac, ephemeris, time, and stored clock 
drift. All board parameters are also set back to factory defaults.

Reset Mode Description

GPS Only Reset Only resets the GPS code without disturbing user defined data

System Reset Forces the code to branch to the start of the Reset Vector (0x0). This 
causes GPS and user defined data to be reset to their default values

Disable Broadcast 
Ephemeris

This causes the receiver to not use broadcast ephemeris and to only 
utilize the ephemeris sent to the receiver. This feature is used for 
testing the extended ephemeris.

Table 3-9 Reset Options  (continued)

Reset Mode Description

SiRFXTrac and 3.0&3.1 
reset options located in 
the bottom right corner of 
the Initialization screen

The 3.2 reset options 
located in the bottom 
right corner of the 
Initialization screen
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Switching to the NMEA Protocol
SiRF GPS products support a subset of the NMEA protocol. Rather than operating in 
the SiRF binary protocol, you can change the protocol to NMEA for the port that is 
currently connected.

Note – When operating in NMEA mode, many of the SiRFDemo display windows and 
functions are not supported.

To change the protocol to NMEA for the port currently connected to your computer:

1. select Switch to NMEA Protocol from the Action menu.

The Select NMEA Messages screen is displayed.

2. Select the NMEA Messages by clicking the required message. 

Option Description

GGA Time, position, and fix related data for a GPS board/receiver.

GLL Latitude and longitude of present position, time of position fix and status.

GSA GPS board/receiver operating mode, satellites used in the position solution, and 
DOP values.

GSV The number of GPS satellites in view satellite ID numbers, elevation, azimuth, and 
SNR values.

RMC Time, date, position, course and speed data provided by the GPS board/receiver.

VTG The actual course and speed relative to the ground.

MSS1 Signal-to-noise ratio, signal strength, frequency, and bit rate from a radio-beacon 
receiver.
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3. Select the update rate for each NMEA message from the corresponding Update Rate 
dropdown menu. 

Each NMEA message can be output at a maximum rate of one per second and at a 
minimum rate of one per 255 seconds.

4. Select the Baud rate from the Baud Rate dropdown menu.

5. Click Send to save or Cancel to exit.

Note – When NMEA is selected as the operating protocol, the output messages can be 
viewed in the Development Data screen. It can also be logged by using the same 
technique as a SiRF binary file. Select 255-Development in the Log File Settings 
screen and check Enable Development Data in the Messages field of the Receiver 
Initialization screen.

Switching to the SiRF Protocol
When operating in SiRF binary protocol, this menu item is unavailable. It can be used, 
however, when operating in NMEA protocol to change the protocol to SiRF binary.

To change the operating protocol from NMEA to SiRF binary:

1. select Switch to SiRF Protocol from the Action menu to return to the SiRF binary 
protocol.

Synchronizing Protocol and Baud Rate
All GPS receiver settings, including selected protocol and serial port settings, are held 
in battery-backed SRAM. When the attached GPS receiver is power cycled, these 
settings remain. When the GPS receiver is left in an unknown state, it is difficult to 
regain communication. 

The synchronize protocol and Baud rate function attempts to change the serial port 
settings of the GPS receiver to a known state of SiRF binary and 38400 Baud. This is 
done by issuing commands to the receiver using all possible Baud rates and NMEA 
and SiRF binary protocols. After this is complete, SiRFDemo resumes operation using 
SiRF binary protocol and 38400 Baud. Since the receiver should also be operating with 
the same settings at this time, communication resumes.

User 8 Reserved for a user defined NMEA string.

User 9 Reserved for a user defined NMEA string.

User 10 Reserved for a user defined NMEA string.

1. When the attached GPS receiver does not support an internal beacon receiver, the content of the MSS messages are not available.

Option Description
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Switching to User1 Protocol
When a user protocol is defined and implemented in the version of software running, 
the Switch to User1 menu item can be used to enable the user defined protocol.

When Switch to User1 is selected, the target platform changes to the user defined 
protocol, but SiRFDemo continues to operate in SiRF Binary.

Note – When the target platform is operating in the user defined protocol, there is no 
direct method through SiRFDemo to switch the target platform back to SiRF Binary. 
An application based on the user protocol must be used, or the Send Serial Message 
ability may be utilized.

To change the operating protocol to a user defined protocol:

1. Select Switch to User1 Protocol from the Action menu.

Setting the Main Serial Port
Use the Set Main Serial Port function to change the Baud rate of the serial port 
connected to the GPS receiver and the serial port of the computer.

To change the Baud rate of the port used by the GPS receiver and the computer:

1. Select Set Main Serial Port from the Action menu.

The Set Serial Port Parameters screen is displayed.

2. Select the Baud rate from the dropdown menu.

3. Click Send to reset the GPS receiver and computer serial port to start 
communicating using the new Baud rate.

Setting the DGPS Serial Port Parameters
The Set DGPS Serial Port Parameters function configures the second serial port (the 
serial port not currently used by the SiRFDemo software) of the attached GPS receiver 
for reception of RTCM data. 

To configure the available port for RTCM reception:

1. Select Set DGPS Serial Port from the Action menu.
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The Set DGPS Serial Port Parameters screen is displayed.

2. Select the Baud rate, data bits, parity, and stop bits for the DGPS serial port 
parameters from each dropdown menu.

3. Click Send to reset the connected GPS receiver and change the protocol of the 
second port to RTCM and the serial port settings to the selected values.

Note – The differential correction data source must be configured separately. See 
“Defining the Data Source” on page 3-3.

Setting the UART Configuration
The UART configuration control is supports four unique UARTS. You can configure 
UART settings such as protocol, Baud rate, data bits, parity, and stop bits using the 
UART configuration control. 

The UART configuration control is provided primarily for system developers. Even 
though control over four UARTs is provided, most products only support two UARTs.
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To set the UART configuration of the attached SiRF GPS product for the two 
supported UARTs:

1. Select Set UART Configuration from the Action menu.

The UART Configuration screen is displayed.

Note – The COM ports supported in a standard GPS receiver are UART 0 (CPU SCIO 
0, COM-A) and UART 1 (CPU SCIO 1, COM-B).

2. Check the Set checkbox for each UART you want to apply changes to.

When the Set checkbox is not checked, the existing configuration remains in its 
current state.

3. Select SiRF binary, NMEA, RTCM, or No I/O from the Protocol selection list.

Select No I/O from the Protocol dropdown menu to disable the data output from 
any port. Each protocol can only be supported by one UART. You cannot configure 
two different ports to use the same protocol.

4. Select the appropriate serial communication parameters using the selection lists for 
Baud rate, data bits, parity, and stop bits.

5. Click Send to accept or Cancel to exit.
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Uploading an Almanac to a GPS Receiver
An almanac file is used by a GPS receiver to assist with locating and tracking available 
satellites. When a current almanac file does not exist in the GPS receiver due to a cold 
start or when it is not used for a long period of time, loading a recent almanac file 
assists the GPS receiver in locating and tracking satellites.

To upload an almanac file to a GPS receiver:

1. Select Set Almanac from the Action menu.

The Specify Almanac Data Filename To Load screen is displayed.

2. Select the file you want to use.

3. Click Open.

Note – The almanac file must be in the same format as polled from a SiRF GPS 
receiver. To download an almanac file from a GPS receiver, see “Downloading an 
Almanac File” on page 3-61.

Uploading an Ephemeris to a GPS Receiver
An ephemeris is used by a GPS receiver to calculate the position of the satellites and 
hence, the position of the GPS receiver. When an ephemeris file is not available, it 
must be downloaded from a GPS satellite. To eliminate the time required to download 
this information from the GPS constellation, a current ephemeris file can be uploaded 
to a GPS receiver using the SiRFDemo software. 

To upload an ephemeris file to a GPS receiver: 

1. Select Set Ephemeris from the Action menu.
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The Specify Ephemeris Data Filename To Load screen is displayed.

2. Select the file you want to use.

3. Click Open.

Note – The ephemeris file must be in the same format as polled from a SiRF GPS 
receiver. To download an ephemeris file from a GPS receiver, see “Downloading an 
Ephemeris File” on page 3-61.

Opening an Extended Ephemeris File
An extended ephemeris is used by a GPS receiver to quickly calculate a position fix 
while the GPS receiver is still downloading a broadcast ephemeris. When an extended 
ephemeris file is not available or has expired, it must be downloaded from the 
SiRFInstantFix server.

See the SiRFGetEE User Guide for instructions about getting an extended ephemeris.

To open an extended ephemeris file: 

1. Select Extended Ephemeris from the Action menu.

The Specify EE File screen is displayed. 

2. Select the file you want to use.
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3. Click Open.

Switching Operating Mode
It is possible to place a GPS receiver into a test operating mode. This mode allows a 
single selected satellite to be tracked by all 12 channels of the GPS receiver.

To place a GPS receiver into test mode:

1. Select Switch Operating Mode from the Action menu.

The Operating Mode screen is displayed.

2. Select Test 1, Test 2, Test 3, or Test 4 when you want to track a specific satellite on 
all channels and output test results. Test 2 outputs additional data to that of Test 1.

Note – Test 1, Test 2, Test 3, and Test 4 enables Testmode 1, Testmode 2, and 
Testmode 3 data respectively. For a full description of each testmode, refer to the SiRF 
Binary Reference Manual.

3. In the Period field, enter the output rate of the test reports in seconds.

4. Enter the SV number that you want to be tracked by all 12 channels of the GPS 
receiver.

5. Select Normal (default) to track all available satellites.

6. Click Send to send the command to the GPS receiver.

When the GPS receiver is changed to a test mode, every channel on the receiver 
tracks only the satellite specified. 
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This can be confirmed by viewing the 12-Channel Signal Level view.

Disabling a Broadcast Ephemeris
The Disable Broadcast Ephemeris is only available when 3.2 is selected as the target 
software in the Setup menu.

To disable a broadcast ephemeris:

Select Disable Broadcast Ephemeris from the Action menu. 

Selecting this dropdown menu option sends msgID 0xE8, subID 0xFF, with debug 
flags data = 0x01000000

A broadcast ephemeris can also be disabled by checking the Disable Broadcast Eph 
checkbox in the Receiver Initialization screen by selecting Action Menu | Initialize Data 
Source. This sends msg 0xE8, subId 0xFF every second to the main serial port until 
the Ack message 0x38, 0xFF is received.

Note: The Ephemeris Info screen shows whether SiRFDemo is still sending the disable 
broadcast eph msg. See also “Ephemeris Information” on page 3-24.
3-44 SiRFDemo User Guide—March 2006 



3

Setting Low Power Parameters

Note – Not valid when operating in SiRFDRive mode.

The GPS receiver can operate in three modes:

Note – Low power mode is not supported by SiRFDRive. This menu is disabled when 
SiRFDemo is set up for SiRFDRive.

TricklePower
In this mode, the power to the GRF2i/LP chip is cycled regularly, according to two 
user-specified parameters: 

• Update Rate
• OnTime
• Maximum Off Time
• Maximum Search Time

During TricklePower operation, the GRF2i/LP chip is powered on for OnTime (in 
milliseconds), then powered off for a specified number of milliseconds as determined 
by the update rate. This cycle repeats indefinitely.

The GSP2e/LP chip is not explicitly powered down, but its primary operation is driven 
by the GPS clock generated by the GRF2i/LP, so it draws very little power while the 
GRF2i/LP is powered down. The real-time clock (RTC) portion of the GSP2e/LP 
continues operation at all times, and is used to generate the interrupt that turns 
everything back on.

The microprocessor on which the SiRF code executes is not explicitly powered down. 
After the OnPeriod has elapsed, the processor continues operating long enough to 
complete its navigation tasks, then puts itself in sleep mode until it is reawakened by 
the RTC-generated wake-up interrupt.

The default parameter values are:

• Update Rate = 1 second
• On Time = 200 ms

Mode Description

Full Power Full power mode is the standard operating mode. Power is supplied to the 
receiver continuously and the GPS receiver continues to operate without an 
interrupt.

TricklePower In TricklePower mode, the power to the SiRF chipset is cycled periodically, so 
that it operates only a fraction of the time. Power is applied only when a 
position fix is scheduled.

Push-to-Fix In Push-to-Fix mode, the GPS receiver is generally off, but turns on frequently 
enough to collect ephemeris data to maintain the GSP1 real-time clock 
calibration so that, upon user request, a position fix can be provided quickly 
after power-up.
Using the SiRFDemo Software 3-45



3

• Maximum Off Time = 30,000 ms
• Maximum Search Time = 120,000 ms

Adaptive TricklePower
An Adaptive TricklePower option is also available. Adaptive TricklePower is a feature 
of the software that allows the receiver to operate in TricklePower when possible, but 
then switch to full power when difficult environments are encountered. Once the 
operating environment improves, the receiver returns to TricklePower mode. This 
function results in improved navigation performance in difficult environments while 
still minimizing power use in good operating environments.

Push-to-Fix
For applications where a position fix is required on demand (that is, not continuous), 
the Push-to-Fix mode is the most appropriate mode of operation for power sensitive 
situations. In this mode, the receiver turns on periodically according to the user 
specified parameter:

Push-To-Fix Period

When the receiver turns on, the ephemeris records are updated and the clocks 
calibrated. When all internal updating tasks are complete, the receiver powers itself off 
(except for RTC) and schedules the next wake-up period. 

The default parameter is:

Push-To-Fix Period = 1,800 seconds

When the GPS receiver is power cycled externally, a navigation solution is be 
available to the user in three seconds.

To set the GPS receiver to TricklePower mode:

1. Select Set TricklePower Parameters from the Action menu.

The Low Power screen is displayed.

2. Select the required operating mode.
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3. When TricklePower is selected, select the Update Rate and On Time from the 
dropdown menu and enter the Maximum Off Time and Maximum Search Time.

4. Select the Adaptive mode checkbox when Adaptive TricklePower operation is 
required.

5. Click Send to activate selection.

Table 3-10 shows the Update Rate and On Time combinations that the GPS receiver 
supports when in TricklePower.

To conserve power at start-up, you can control how long (Maximum Search Time) the 
system should attempt to acquire satellites and navigate, and how long (Maximum Off 
Time) the GPS receiver should remain off (sleep mode) before making another attempt 
to navigate. Maximum times are in ms. 

Example: Maximum Off Time 30000 ms (default) 
Maximum Search Time 300000 ms (default)

Scenario 1: System is turned on, but does not acquire Svs (no antenna connected). 

Result: System searches for 120000 ms, sleeps for 30000 ms, searches again for 
120000 ms, etc.

Scenario 2: System is turned on and acquires Svs, but does not navigate. 

Result: System searches for 120000 ms, sleeps for 30000 ms, searches again for 
120000 ms, etc. 

Scenario 3: System is turned on, acquires and navigates.

Result: Sleep mode is disabled.

Table 3-10 TricklePower: Update Rate and On Time 

Update Rates (seconds)

On Time (ms) 1 2 3 4 5 6 7 8 9 10

200

300

400

500

600

700

800

900
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Setting Advanced Power Management Options for SiRFXTrac
When using SiRFXTrac, the Advanced Power Management (APM) mode can be 
enabled or disabled. When the APM mode is enabled, settings for accuracy and timing 
plus many other power management options are available.

To view the SiRFXTrac APM settings:

1. Select Set Advanced Power Management (APM) from the Action Menu.

The XTrac APM screen is displayed.

Setting the Message Rate
You can configure each SiRF binary output message so that it is output using a 
specified frequency.

To set the SiRF binary output rates:

1. Select Set Message Rate from the Action Menu.

The Message Rate screen is displayed.
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2. Select the appropriate SiRF binary message from the Message name dropdown 
menu.

3. Enter the rate at which you want the selected SiRF binary message to be output.

4. Check the Send Message Now checkbox to send the message now.

5. Click Send.

Note – The message rate is based on navigation cycles, not seconds. For example, in 
TricklePower mode at an update rate of two seconds, selecting five as the message 
output rate outputs the selected message every Ten seconds. Ten seconds, in this case, 
is equivalent to five navigation cycles. An Update Rate of zero disables the output of 
that message.

The decrement of the navigation cycle counters for each message begins when the GPS 
receiver accepts and verifies the input command. Each message is done separately and 
no mechanism is currently in place to synchronize message output. Message counters 
are stored in DRAM so they are preserved over hot and warm software resets but 
revert to default values over power cycles, cold, and factory resets.

Transmitting a User Defined Serial Message
The Transmit Serial Message function provides the ability for a user to send generic 
serial messages to the attached target platform. The message can be automatically 
wrapped with SiRF Binary or NMEA information, or transmitted as is.

To transmit a user defined message to the target platform:

1. Select Transmit Serial Message from the Action menu.

The Send Data screen is displayed.
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2. Enter the payload of the message that you want to send to the target platform in the 
text field.

Use Hex format for a binary message content or ASCII for intended NMEA 
messages.

Note – The defined message can be saved in a .cmd file by clicking Save and 
specifying a file name. A previously defined message that was saved can be loaded by 
clicking Load and selecting the appropriate file.

3. Select the desired protocol wrapper from the Protocol Wrapper options.

4. Click Send to send the defined message to the target platform.

The Navigation Menu
This section describes the SiRFDemo software functions under the Navigation menu:

• “Setting Mode Mask Control” on page 3-51

• “Setting the DOP Mask Control” on page 3-53

• “Selecting an Elevation Mask” on page 3-53

• “Selecting a Power Mask” on page 3-54

• “Enabling/Disabling the Static Navigation” on page 3-55

Option Description Default

SiRF Binary The payload of the message is converted to binary with 
the appropriate SiRF Binary start sequence, payload 
length, message checksum, and end sequence is calculated 
and added to the payload.

On

NMEA 
(S..<data>..*ck\r\n)

The appropriate NMEA format start sequence, message 
checksum, and end sequence is calculated and added to 
the payload.

Off (8)

None (HEX) Converts Hex to binary with no additional header Off (8)

None (ASCII) Sends ASCII data Off (8)
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• “Setting the DGPS Mode” on page 3-55

• “Selecting the DGPS Source” on page 3-56

• “Setting the SBAS Operating Mode” on page 3-57

Setting Mode Mask Control
Navigation mode control is used to configure the specifics of how a GPS receiver 
navigates or calculates a position. In particular, selecting how a position should be 
derived when a minimum number of satellites are not available to calculate a full 3D 
position.

To set the navigation mode control:

1. Select Mode Mask from the Navigation menu.

The Navigation Moding screen is displayed.

2. Select the required navigation mode options.

Table 3-11 Navigation Mode Options  

Option Description Default

Enable Track 
Smoothing

Enables smoothing of the calculated positions based on acceptable 
variances from the last calculated position. This assists in eliminating 
any sporadic position jumps possibly caused by multipath, for 
example.

Off

Altitude Hold Mode

Automatic Switch automatically to a 2D solution and hold the altitude fixed 
when only three satellites are available. A 3D solution is calculated 
when four or more satellites are available.

On

Always Stay in 2D mode regardless of the number of satellites available. The 
altitude always remains fixed.

Off

Disable 
Altitude Hold

Only calculate 3D solutions. When it is not possible to calculate a 3D 
solution due to insufficient satellites, no navigation is provided.

Off
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3. Click Send to accept or Cancel to exit.

Last 
Computed 
Altitude

When the GPS receiver is operating in 2D mode, the altitude is held 
to the last known altitude calculated by the GPS receiver.

Off

Fixed 
Altitude

When the GPS receiver is operating in 2D mode, the altitude is held 
to the value entered in the Fixed Altitude field.

Off 

Degraded Modes

Use Direction 
then Clock 
Hold

When the number of available satellites is reduced to two, the GPS 
receiver holds the elevation fixed, and uses the last direction and 
doppler values (change in distance) to continue positioning. When the 
available satellites is then reduced to one, the clock bias is then 
extrapolated.

Off

Use Clock 
then Direction 
Hold

This mode is similar to the above Direction then Clock Hold mode. 
However, the clock bias is extrapolated first, and then the direction 
and doppler measurements are used.

On 

Direction 
(Curb) Hold 
Only

This mode restricts positioning to using direction hold only and does 
not use the extrapolating the clock bias method. Two satellites must 
be available.

Off

Clock (Time) 
Hold Only

Positioning is restricted to using the clock bias extrapolation method 
only and does not hold the direction. Two satellites must be available.

Off

Disable 
Degraded 
Mode

When less than three satellites are available, no position is calculated. Off

Timeout The GPS receiver only operates in any degraded mode for the period 
of time specified by the timeout.

30

Dead Reckoning

Enable Dead 
Reckoning 
Mode

When a position solution is not possible due to insufficient satellites, 
a positions is calculated using the last known velocity. Only applies 
when the GPS receiver is being used in a dynamic environment.

On 

Timeout The GPS receiver only calculates positions using dead reckoning for 
the period of time specified by the timeout. 

15

Table 3-11 Navigation Mode Options  (continued)

Option Description Default
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Setting the DOP Mask Control
This mask enables you to control the position output of a GPS receiver so that 
positions computed with a high DOP value are not output. When the DOP mask is 
exceeded, the position message status changes to DOP mask exceeded and the position 
does not update.

To set the DOP mask controls:

1. Select DOP Mask from the Navigation menu.

The DOP Mask screen is displayed.

2. Select the Mode that you want to use.

3. Enter a DOP mask value for the corresponding selected DOP mask.

For each of the DOP masks, the default value is 10. This value is a maximum value 
and the mask applies when the current set mask is exceeded.

4. Click Send to accept or Cancel to exit.

Selecting an Elevation Mask
GPS satellites that are low on the horizon are subject to noise due to the amount of 
atmosphere that the signal must travel through. Better position accuracy is often 
achieved when lower elevation satellites are not used in the position solution. The 
elevation mask is used to exclude the use of satellites in the position solution that are 
below a defined elevation mask.

Option Description Default

Auto PDOP/HDOP The PDOP mask is used when four or more satellites are 
available. When only three satellites are available, the HDOP 
mask is used.

Off 

Use PDOP only Only the PDOP mask is used regardless of the number of 
satellites available.

Off (8)

Use HDOP only Only the HDOP mask is used regardless of the number of 
satellites available.

Off (8)

Use GDOP only Only the GDOP mask is used regardless of the number of 
satellites available.

Off (8)

Do not use No DOP based mask is applied. Any available position is 
output regardless of any of the DOP values.

On
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To select an elevation mask:

1. Select Elevation Mask from the Navigation menu.

The Elevation Mask screen is displayed.

2. Enter the minimum elevation angle for satellites to be used in any position solution. 

3. Click Send to accept or Cancel to exit.

Selecting a Power Mask
GPS satellites that have a low signal strength are not easily tracked by a GPS receiver 
and may result in using signals that are either noisy or have been effected by multipath 
or other interference source. To increase accuracy, it may be necessary to exclude GPS 
satellites with a signal strength below a selected value.

Note – Not valid when operating in SiRFDRive mode.

To exclude satellites from the position solution with a signal strength below a selected 
value:

1. Select Power Mask from the Navigation menu.

The Power Mask screen is displayed.

2. Enter the minimum satellite signal level for satellites to be used in any position 
solution.

3. Click Send to accept or Cancel to exit.
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Enabling/Disabling the Static Navigation
The steady state detection allows the navigating algorithms to decrease the noise in the 
position output when the acceleration is below the threshold. This reduces the position 
wander caused by Selective Availability (SA) and improves position accuracy 
especially in stationary applications.

To select the static navigation mode:

1. Select Static Navigation from the Navigation menu.

The Static Navigation screen is displayed.

2. Select the option that you want to use.

3. Click Send to accept or Cancel to exit.

Note – The Static Navigation filter is Disabled when DGPS corrections are used in the 
navigation solution.

Setting the DGPS Mode
The DGPS mode is used to control the position output of a GPS receiver based on 
whether positions are differentially corrected.

To set the DGPS mode:

1. Select DGPS Mode from the Navigation menu.

The DGPS Mode screen is displayed.

Option Description Default

Disable Displays true user movement due to SA (and other environmental issues 
such as multipath).

Yes

Enable Holds the current position as fixed when the user is in a stationary 
mode. Updates to the fixed position due to SA are made based on 
internal navigation data. 

No
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2. Select the Mode that you want to use.

3. Enter the timeout value (in seconds) you want to use in the Timeout field.

A received differential correction is applied to the solution until either the timeout 
value is exceeded, or a new differential correction is received.

4. Click Send to accept or Cancel to exit.

Note – For a differential position to be calculated, there must be pseudorange 
corrections for every pseudorange used in the solution. When pseudoranges are 
without corrections and the GDOP improves by two by using all pseudoranges, the 
solution does not use available corrections.

Selecting the DGPS Source
Many SiRF products have the ability to receive RTCM differential corrections from 
different sources. The DGPS source control is used to select which source is used to 
obtain RTCM differential corrections.

To select the DGPS source:

1. Select DGPS Source from the Navigation menu.

The DGPS Source screen is displayed.

Option Description Default

Automatic Use differential corrections when they are available, otherwise compute 
a non-differential solution. (See the Note that follows.) 

On

Exclusive Only compute a differential solution. When no corrections are available, 
no solution is output.

Off

Never use Only compute a non-differential solution (even when corrections are 
valid).

Off
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2. Select the Source that you want to use.

3. When the Internal DGPS Beacon Receiver is the chosen DGPS source, select the 
auto scan options. 

4. Click Send to accept the settings.

Note – The selection made in the DGPS Source screen is displayed in the DGPS Status 
View screen by selecting Messages | DGPS Status from the View menu.

Setting the SBAS Operating Mode
SBAS support can be configured using the SBAS configuration dialog.

To select the SBAS operation:

1. Select SBAS Control from the Navigation menu.

The SBAS screen is displayed.

Option Description Default

None The GPS receiver does not use any of the available DGPS sources. No

SBAS Channel The GPS receiver uses the SBAS correction service when available. 
One of the twelve channels is dedicated to the SBAS signal.

No

External 
RTCM Data

The GPS receiver uses any RTCM corrections that are input 
directly through one of the serial ports.

Yes

Internal DGPS 
Beacon 
Receiver

The internal beacon receiver is used to provide RTCM corrections 
received from an operating radio-beacon. A beacon antenna is 
required.

No

Auto Search Description

Frequency The internal beacon receiver automatically scans the radio-beacon frequency 
range until a usable signal is acquired. When this option is deselected, you must 
enter a signal frequency for the beacon receiver to use.

Bit Rate Radio-beacons can broadcast the correction information using different bit rates 
(the number of bits of data per second). When this option is selected, the 
internal beacon receiver also searches the different available bit rates until a 
usable signal is acquired. When this option is deselected, you must select a 
signal bit rate for the beacon receiver to use.
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2. Select the required operating parameters.

3. Click Send to accept the settings.

The Poll Menu
This section describes the SiRFDemo software functions under the Poll menu:

• “Polling the Clock Status” on page 3-59

• “Polling the Navigation Parameters” on page 3-60

• “Downloading an Almanac File” on page 3-61

• “Downloading an Ephemeris File” on page 3-61

• “Polling the Ephemeris State” on page 3-62

• “Polling the Extended Ephemeris” on page 3-62

Option Description Default

SBAS 
PRN

When set to Auto Scan, the GPS receiver automatically searches for and use 
any available SBAS correction source. Otherwise, it only uses corrections 
from the SBAS source identified by the PRN entered in the PRN field.

Auto 
Scan

Mode Used to indicate the current operating mode of the SBAS system being 
used. The operating mode is displayed in the DGPS View screen. See “The 
DGPS View Screen” on page 3-15.

Testing

Timeout 
Source

When set to default, the timeout as provided by the SBAS system is used 
(this is typically 18 seconds). When User Defined is selected, the timeout 
value as set by the DGPS Mode dialog is used. See “Setting the DGPS 
Mode” on page 3-55.

Default
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Viewing the Software Version
The poll software version function allows you to query a GPS receiver for the version 
of embedded software currently being run.

To view the current software version:

1. Select SW Version from the Poll menu.

The Response View screen is displayed showing the software version currently 
being run. 

Polling the Clock Status
The poll clock status function allows you to query a GPS receiver for clock 
performance information including the GPS week number, GPS time, clock drift, and 
clock bias.

To poll a GPS receiver for clock status information:

1. Select Clock Status from the Poll menu.

The Response View screen is displayed with the clock status.

The following table provides a description of the clock status items.

Item Description

Week Number of continuous weeks that GPS has been operational. The start date 
being January 6, 1980.

TOW Time of Week—the number of GPS seconds since the start of the current 
GPS week. The start of the GPS week being 0 hrs Sunday UTC.

EstGPS Time Estimated TOW while the GPS receiver is not tracking GPS satellites.

SVCnt Number of satellites currently being tracked and used in the position solution.

Clock Drift Change in the clock bias. A typical range is between 76kHz and 116kHz. 

Clock Bias Offset of the GPS receiver clock compared with the current GPS time.
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Polling the Navigation Parameters
All of the user settings that have been set under the Action and Navigation menus can 
be polled for their current status and settings.

To poll a GPS receiver for its current navigation parameters:

1. Select Navigation Parameters from the Poll menu.

The current settings are displayed in the Response View window.

A description of each of the navigation parameters are given in the following table.

Table 3-12 Navigation Parameters  

Parameter Description

AltMode Selected altitude hold mode.

AltSource Altitude type used when a 2D solution is being calculated.

Altitude Altitude used when fixed manually.

DegradeMode Type of degraded mode selected.

DegradedTimeout Timeout value applied to degraded mode operation.

DR Timeout Timeout value applied to dead reckoning navigation.

TrkSmoothMode Enable or disable state of track smoothing.

StaticNav Enable or disable state of the static navigation mode.

3SV LSQ Indicates the state of a start-up mode that allowS start-up when only three 
satellites are available.

DOPMaskMode Selected DOP mask control.

ElevMask Currently used elevation mask.

PwrMask Currently used power mask.

DGPSSrc Selected DGPS source.

DGPSMode Selected DGPS mode.
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Downloading an Almanac File
You can download an almanac file from a SiRF GPS receiver and load it back into the 
receiver at a later date or to another GPS receiver. This is to assist with initial satellite 
tracking. This file may also be used for mission planning and constellation 
investigations.

To download an almanac file:

1. Select Almanac from the Poll menu.

The Specify Almanac Data Filename To Save screen is displayed.

2. Specify the file name in which to save the almanac information.

3. Click Save to save the data to file. 

A message box is displayed to confirm completion.

To load an almanac file, see “Uploading an Almanac to a GPS Receiver” on page 3-41.

Downloading an Ephemeris File
You can download an ephemeris file from a SiRF GPS receiver and load it back into 
the receiver at a later date or to another GPS receiver. This is to assist with initial 
position calculations. This file may also be used for mission planning and constellation 
investigations.

DGPSTimeout Timeout value applied to DGPS corrections.

Power Mode indicates the current power mode of the GPS receiver, which is either 
TricklePower or continuous power.

User Task User status: enabled or disabled (default)

MaxAcqTime Maximum Acquisition Time.

MaxOffTime Maximum Off Time.

Table 3-12 Navigation Parameters  (continued)

Parameter Description
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The downloaded ephemeris, which contains information on the status of each satellite, 
could have been acquired from a broadcast ephemeris, an extended ephemeris, or a 
combination of both, depending on what SiRF GPS product was being used.

To download an ephemeris file:

1. Select Ephemeris from the Poll menu.

The Specify Ephemeris Data Filename To Save screen is displayed.

2. Specify the file name that you want to save the ephemeris information to.

3. Click Save to save the data to file. 

A message box is displayed to confirm completion.

To load an ephemeris file, see “Uploading an Ephemeris to a GPS Receiver” on page 
3-41.

Polling the Ephemeris State
Polling the ephemeris state sends msg 56, subID 3, and the response can be viewed by 
selecting Messages | Response in the View menu.

The ephemeris state can also be polled by selecting Messages | Ephemeris Info from 
the View menu, which is graphically displays the message response. See “Ephemeris 
Information” on page 3-24.

Polling the Extended Ephemeris 
The Ext Eph Info menu item polls the currently loaded SiRF extended ephemeris for 
information about its download date, age, and valid time remaining.

To poll the currently loaded ephemeris file:
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1. Select Extended Ephemeris from the Poll menu.

The Extended Ephemeris Information screen is displayed.
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The SiRFDRive Menu
This section describes the SiRFDemo software functions under the SiRFDRive menu:

• “Setting Navigation Mode Control” on page 3-63

• “Calibrating the Gyro” on page 3-64

• “Setting DR Sensor Parameters” on page 3-64

• “Polling Gyro Factory Calibration” on page 3-65

• “Polling DR Sensor’s Parameters” on page 3-65

Note – The SiRFDRive menu is only available when DiRFDrive and SiRFNav & 
SiRFDRive is selected as the target software.

Setting Navigation Mode Control
To set the SiRFDRive navigation mode control:

1. Select SiRFDRive | Navigation Mode Control from the Navigation menu.

The SiRFDRive Navigation Mode Control screen is displayed. 

2. Select the radio button for a SiRFDRive Navigation Mode.

Navigation Mode Description

GPS Nav Only User can configure the device to use GPS navigation only (DR 
sensors are not used for navigation).

DR Nav Only Dead reckoning navigation is used exclusively, GPS updates are 
received but not used for navigation.

DR Nav Ok w/ stored or 
default calibration

DR navigation can be specified at startup by using DR sensor 
calibration stored in RAM (i.e., OK to do DR only at startup when 
no update from GPS is available). This is the default navigation 
mode at startup.

DR Nav OK w/ current 
GPS calibration

DR Navigation must use current GPS-based calibration (i.e., no DR 
Navigation after startup until after calibration by GPS).
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3. Click Send to accept the setting.

Calibrating the Gyro
The factory calibration procedure requires that the “Start Gyro Bias Calibration” be 
done first while the gyro is stationary, and then the “Gyro Scale Factor Calibration” be 
done while the gyro rotates smoothly through 360 degrees.

To start the gyro calibration:

1. Select SiRFDrive | Poll Gyro Factory Calibration from the Navigation menu.

2. Select SiRFDrive | Gyro Factory Calibration from the Navigation menu.

The SiRFDRive Gyro Factory Calibration Control screen is displayed.

3. Check the Start gyro bias calibration checkbox.

4. Click Send.

5. Wait for the “Gyro Bias Calibration Finished” message in the Response View.

6. Select SiRFDrive | Gyro Factory Calibration from the Navigation menu.

7. Check the Start gyro scale factor calibration checkbox.

8. Click Send.

9. Rotate Gyro through exactly 360 degrees using highest possible angular rate, or at 
least 40 deg/sec.

10. Wait for the “Gyro Scale Factor Calibration Finished” message in the Response 
View.

Setting DR Sensor Parameters
To enter the following DR sensor parameters:

• Speed scale factor (meters per wheel tick)

• Gyro Bias (zero rate volt)

• Gyro Scale Factor mV / (deg/sec)

1. Select SiRFDrive | DR Sensor’s Parameters from the Navigation menu.
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The SiRFDRive DR Sensor’s Parameters screen is displayed.

2. Enter the new parameters or check the Use default values checkbox.

3. Click Send to accept the setting.

Polling Gyro Factory Calibration
This command provides status information during the Gyro Factory Calibration 
process. Refer to “Calibrating the Gyro” on page 3-64 for usage.

Polling DR Sensor’s Parameters
This command reads the current DR sensor values:

• Speed Scale Factor - meters / wheel tick

• Gyro Bias - zero rate volt

• Gyro Scale Factor - mV / (deg/sec)

To read the current DR sensor parameter values:

1. Select SiRFDRive | DR Sensor’s Parameters from the Navigation menu. 

The Response View screen is displayed.
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SiRFDemo Real Time View Windows A
SiRFDemo provides view windows for real time monitoring of SiRF GPS receivers. 
Each view windows displays information based on one or more SiRF Binary receiver 
output message(s) as described in the following table.

Table A-1 SiRFDemo View Window 

Window Name Messages Comments

Signal View 2, 4, 30 Message 4 describes everything except the blue/green color distinction, which is 
based on SVs used in the navigation solution from message 2, and green/magenta 
color distinction based on the extended ephemeris flags from message 30. 
Message 30 pertains to all software except SiRFXTrac and SiRFLoc Client.

Radar View 2, 4, 30 Message 4 describes everything except the blue/green color distinction, which is 
based on SVs used in the navigation solution from message 2, and green/magenta 
color distinction based on the extended ephemeris flags from message 30. 
Message 30 pertains to all software except SiRFXTrac.

Map View 2, 41 Message 2 describes everything except message 41, which is used for the heading 
field when SiRFDemo is configured for SiRFDRive.

Navigation View 2, 41 Message 2 describes everything except message 41, which is used for the heading 
field when SiRFDemo is configured for SiRFDRive.

Debug View 255 and All 
NMEA Messages

Displays the text from SiRF Binary debug messages (MID 255) and displays 
NMEA text messages when available.

Response View 6, 7, 11, 12, 19, 
45, 48

MID_SWVersion(6), MID_ClockStatus(7), MID_Ack(11), MID_Nak(12), 
MID_RxMgrParams(19) with subid 0 for regular nav, subid 1 for APM nav, 
MID_TrkADCOdoGPIO(45), MID_DrOut(48) with subids 5 for DrValid, 6 for 
GyrFactCal, and 7 for DRSensParam. Messages 45 and 48 pertain only to 
SiRFDRive.

Error View 10, 255 SiRF Binary message 10 error codes are converted to human readable strings, 
message 255 strings flagged as errors are displayed in this window instead of the 
debug view window. Message 255 for the Aux Output View pertains only to 
SiRFDRive.

Output View All Messages 
0-255

This view displays each message ID received in both decimal and hex, along with 
the SiRF Binary message name for that message ID. Message 255 pertains only to 
SiRFDRive

DGPS View 27, 50 MID_DGPSStatus(27), MID_SbasStatus(50). Message 27 pertains to all software 
except SiRFXTra. Messages 50 pertains only to GSW2.
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Geodetic Nav View 41 Some additional fields are displayed for SiRFDRive (Reverse Flag) or Fusion 
(Map Matching) GPS receiver software under test.

PPS Timing View 52 MID_PPS_Time(52). Message 52 pertains only to GSW2.

Aux Output View 172, 255 MID_DrIn(172), MID_ASCIIData(255); this is not only message 255, but can be 
any text data received on the aux data source channel. This window is specifically 
designed for SiRFDRive 2 development. Messages 172 and 255 pertain only to 
SiRFDRive.

Ephemeris Info View 30, 56 Messages used are clearly indicated in the display window; for message 56 
several subids are handled – 255 sub id 1 and sub id 3. This window is designed 
specifically for GSW 3.2 development and for future extended ephemeris 
products. Message 30 pertains to all software except SiRFXTrac. Message 56 
pertains only to GSW3.

Table A-1 SiRFDemo View Window (Continued)

Window Name Messages Comments
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File Formats B
This appendix describes the format of files that are either used by the SiRFDemo 
software or are created by the SiRFsig software. It includes information on the 
following:

• “Modifying the Sample sirf.pos File” 

• “Description of SiRFsig File Formats” 

Modifying the Sample sirf.pos File
The sirf.pos file can be used by the Receiver Initialization dialog to load predefined 
coordinates.

To modify the sirf.pos file:

1. Open the sample sirf.pos file using a text editor.
The sample X, Y, Z positions are displayed.

2. Use the configuration values displayed on the Measured Navigation Message View 
screen as your new X, Y, and Z coordinates after communication is established with 
the GPS receiver.  

-2686718
-4304272
3851636
0
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3. Modify the X, Y, Z positions in the sirf.pos file with the new configuration 
values displayed on the Measured Navigation Message View screen.

Description of SiRFsig File Formats
The SiRFsig software produces the following files for plotting and statistics:

• *.avg
• *.pos
• *.vel
• *.### 
• *.svs

Following are descriptions of each type of file.

*.avg File
*.avg is the average data file used to calculate statistics. It is created during parsing 
and used if data is reviewed without re-parsing the data file. 

Format
Lines 0-32 are satellite data. All fields are 0 if Sv is not tracked. 

Sv Avg C/No Number of Seconds Tracked
0 0.00 0
0 0.00 0
2 47.00 3631
0 0.00 0
0 0.00 0
0 0.00 0
0 0.00 0
7 45.44 3630
.. .... ...
.. .... ...

31 38.02 3467
0  0.00 0

-2690721
-4310924
3841682
0
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Bin Data for Polar Plots
Bins are in a matrix of [8][8] with each bin defined by an azimuth range and elevation 
range. Bin[0][0]is AZ 0-45 and El. 0-10 degrees, Bin[0][1] is Az 0-45, El 10-20 
degrees. Bin azimuths are in steps of 45 degrees in a clockwise direction, elevation 
bins are in 10 degree steps starting at the horizon (0 degrees) and finishing at the 
zenith (90 degrees). 

This is the start and end time of the data session in GPS seconds into the week.

This is the average position of the board/receiver in ECEF XYZ coordinates.

This is the average velocity of the board/receiver in ECEF XYZ coordinates.

This is the board/receiver software version.

This is the data protocol of the board/receiver.

This is the Power settings of the board/receiver.

This is the Elevation Mask in degrees.

This is the DGPS mode of operation.

Bin Bin Avg. C/No # of Data Max C/No Min C/No
0 0 34.04 444 37.00 29.00
0 1 38.58 1638 43.00 33.00
.. .. .. .. .. ..
0 8 0.00 0 -1.00 99.00
.. . .. .. .. ..
.. .. .. .. .. ..
7 0 34.12 429 37.00 28.00
7 1 40.59 1638 46.00 35.00
.. .. .. .. .. ..
7 8 0.00 0 -1.00 99.00

Start End
259510.24 263143.18

Px Py Pz
-2686753.9 -4304226.9 3851670.2

Vx Vy Vz
-2686753.9 -4304226.9 3851670.2

Version 200R00234 

201 (protocol) 
1. 20 equals SiRF Binary data, 21 equals NMEA data

Power Mode 10 1000.0 1.0 (mode1, Ontime2 (ms) Update Rate3 (ms) 
1. 10 equals Full Power, 11 equals Trickle Power, 12 equals Push-to-fix 

2. User selected On Time in ms

3. User selected Update Rate in ms

Elevation Mask 7.5 

DGPSmode 10 (10 = Auto, 11 = Exclusive, 12 = Never Use)
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This is the Number of False Acquisitions Detected.

*.pos File
*.pos is the time tagged position file in ECEF XYZ parsed from record 002 
(measured navigation data) of SiRFdemo.

*.vel File
*.vel is the time tagged position file in ECEF Vx, Vy, Vz parsed from record 002 
(measured navigation data) of SiRFdemo.

*.### File
*.### is the satellite specific data for each Sv tracked where ### is the Sv prn 
number. This data is parsed form record 004 (measured tracker data) from SiRFdemo 
(i.e., Satellite data for Sv Number 22 will be in file *.022).

*.svs File
*.svs contains statistics that are generated each time the program processes a data 
file on a per satellite basis.

Statistical data file:*.svs
Statistical data per Sv based on file. 

False Acquisitions 0

 GPS Time Px Py Pz DOP Mode1 Mode2 SVs used Thru put SV tracked

 GPS Time Vx Vy Vz DOP Mode1 Mode2 SVs used Thru put SV tracked

GPS Time Az El. Avg. C/No
256707.11   297  35    44
256708.11  297   35    45
256709.11 297  35    45

Sv Mean Std Dev Max Min Range Data
2 47.0 0.1 47 46 1 7262 
7 45.4 1.2 47 42 5 7260 

10 8.3 2.6 45 28 17 5884 
13 47.0 0.0 47 47 0 72 
15 35.8 3.0 42 28 14 3262 
18 38.6 4.0 45 28 17 3290 
19 46.6 0.5 48 45 3 7262 
26 41.5 4.1 47 28 19 6852 
27 47.0 0.1 47 46 1 7262 
31 38.0 2.8 43 28 15 6934 
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Acronyms and Abbreviations 
Glossary C
2-D Two dimensional

3-D Three dimensional

A/D Analog to Digital

AGC Automatic Gain Control

Almanac A set of orbital parameters that allows calculation of the approximate GPS satellite positions and 
velocities. A GPS receiver uses the almanac as an aid to determine satellite visibility during 
acquisition of GPS satellite signals. The almanac is a subset of satellite ephemeris data and is 
updated weekly by GPS Control.

Altitude The distance between the current position and the nearest point on WGS84 reference ellipsoid. 
Altitude is usually expressed in meters and is positive outside the ellipsoid. In SiRFstar devices, 
this has no bearing on the height above mean sea level.

Altitude Hold A technique that allows navigation using measurements from three GPS satellites plus an 
independently obtained value of altitude.

Altitude Hold Mode A navigation mode during which a value of altitude is processed by the Kalman Filter as if it were 
a range measurement from a satellite at the Earth’s center (WGS-84 reference ellipsoid center).

BA Bus Address

BGA Ball Grid Array

Baud (See bps.)

BOM Bill Of Materials

bps Bits per second

C Celsius, a unit of temperature

C/A Code Coarse/Acquisition Code. A spread spectrum direct sequence code that is used primarily by 
commercial GPS receivers to determine the range to the transmitting GPS satellite.

CEP Circular Error Probable. The radius of a circle, centered at the user’s true location, that contains 
50 percent of the individual position measurements made using a particular navigation system.

Clock Error The uncompensated difference between synchronous GPS system time and time best known 
within the GPS receiver.

CMOS Complimentary Metal Oxide Semiconductor

C/N0 Carrier-to-Noise density ratio.
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Cold Start A condition in which the GPS receiver can arrive at a navigation solution without initial position, 
time, and current Ephemeris.

Control Segment The Master Control Station and the globally dispersed Monitor Stations used to manage the GPS 
satellites, determine their precise orbital parameters, and synchronize their clocks.

dB Decibel

dBiC Decibel-Isometric-Circular (measure of power relative to an isometric antenna with circular 
polarization).

dBm Decibels relative to 1mW

dBW Decibel-Watt (measure of power relative to one watt)

DC Direct Current

DGPS Differential GPS. A technique to improve GPS accuracy that uses pseudorange errors recorded at 
known locations to improve the measurements made by other GPS receivers.

Doppler Aiding A signal processing strategy that uses a measured Doppler shift to help a receiver smoothly track 
a GPS signal to allow a more precise velocity and position measurement.

DoD The U.S. Government Department of Defense

DOP Dilution of Precision (see GDOP, HDOP, PDOP, TDOP, and VDOP).

DSP Digital Signal Processor

DTR Data Terminal Ready. A hardware handshake signal used in serial data links.

ECEF Earth-Centered Earth-Fixed. A Cartesian coordinate system with its origin located at the center of 
the Earth and whose axes rotate with the Earth. The coordinate system used by GPS to describe  
3-D location. For the WGS-84 reference ellipsoid, ECEF coordinates have the Z-axis aligned with 
the Earth’s spin axis, the X-axis through the intersection of the Prime Meridian and the equator, 
and the Y-axis is rotated 90 degrees East of the X-axis.

EA External Address

EEPROM Electrically Erasable Programmable Read Only Memory

EHPE Estimated Horizontal Position Error

EMC Electromagnetic Compatibility

EMI Electromagnetic Interference

EPE Estimated Position Error

Ephemeris A set of satellite orbital parameters used by a GPS receiver to calculate precise GPS satellite 
positions and velocities. The ephemeris is used to determine the navigation solution and is 
updated frequently to maintain the accuracy of GPS receivers.

EPROM Erasable Programmable Read Only Memory

ESD Electrostatic Discharge

EVPE Estimated Vertical Position Error

FP Floating-Point mathematics, as opposed to fixed point (integer).

FRP Federal Radionavigation Plan. The U.S. Government document that contains the official policy on 
the commercial use of GPS.

FSM Finite State Machine

GaAs Gallium Arsenide, a semiconductor material.
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GDOP Geometric Dilution of Precision. A factor used to describe the effect of the satellite geometry on 
the position and time accuracy of the GPS receiver solution. The lower the value of the GDOP 
parameter, the less the errors in the position solution. Related indicators include PDOP, HDOP, 
TDOP, and VDOP.

GMT Greenwich Mean Time

GPS Global Positioning System. A space-based radio positioning system that provides suitably 
equipped users with accurate position, velocity, and time data. GPS provides this data free of 
direct user charge worldwide, continuously, and under all weather conditions. The GPS 
constellation consists of 21 orbiting satellites, plus three to nine on-orbit spares equally spaced 
around each of six different orbital planes. The system is developed by the DoD under Air Force 
management.

GPS Time The number of seconds since Saturday/Sunday Midnight, with time zero being this midnight. 
Used with GPS Week Number to determine a specific point in GPS time.

GUI Graphic User Interface

HDOP Horizontal Dilution of Precision. A measure of how much the geometry of the satellites affect the 
position estimate (computed from the satellite range measurements) in the horizontal (East, North) 
plane.

Held Altitude The altitude value that is sent to the Kalman filter as a measurement when in Altitude Hold Mode.

Hot Start Start mode of the GPS receiver when current position, clock offset, approximate GPS time, and 
current ephemeris data are all available.

Hz Hertz, a unit of frequency equal to one cycle per second.

I/O Input/Output

IF Intermediate Frequency

IRQ Interrupt ReQuest line

ISR Interrupt Service Routine

IGRF International Geomagnetic Reference Field

IODC Issue Of Data Clock

IODE Issue Of Data Ephemeris

JPO Joint Program Office. An office within the U.S. Air Force Systems Command, Space Systems 
Division. The JPO is responsible of managing the development and production aspect of the GPS 
system and is staffed by representatives from each branch of the U.S. military, the U.S. 
Department of Transportation, U.S. Defense Mapping Agency, NATO member nations, and 
Australia.

Kalman Filter Sequential estimation filter that combines measurements of satellite range and range rate to 
determine the position, velocity, and time at the GPS receiver antenna.

km Kilometer (1km = 1000 meters).

L1 The 1575.42MHz GPS carrier frequency that contains the C/A code, P-code, and navigation 
messages used by commercial GPS receivers.

L2 A secondary GPS carrier, containing only P-code, used primarily to calculate signal delays caused 
by the atmosphere. The L2 frequency is 1227.60MHz.
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Latitude Halfway between the poles lies the equator. Latitude is the angular measurement of a place 
expressed in degrees north or south of the equator. Latitude runs from 0° at the equator to 90°N or 
90°S at the poles. When not qualified with letters N or S, it is assumed positive is north of the 
equator and negative is south of the equator. Lines of latitude run in an east-west direction. They 
are called parallels.

LLA Latitude, Longitude, Altitude. Geographical coordinate system used for locating places on the 
surface of the Earth. Latitude and longitude are angular measurements, expressed as degrees of a 
circle measured from the center of the Earth. The Earth spins on its axis, which intersects the 
surface at the north and south poles. The poles are the natural starting place for the graticule, a 
spherical grid of latitude and longitude lines. See also Altitude.

LNA Low Noise Amplifier

Longitude Lines of longitude, called meridians, run in a north-south direction from pole to pole. Longitude is 
the angular measurement of a place east or west of the prime meridian. This meridian is also 
known as the Greenwich Meridian, because it runs through the original site of the Royal 
Observatory, which was located at Greenwich, just outside London, England. Longitude runs from 
0° at the prime meridian to 180° east or west, halfway around the globe. When not qualified with 
letters E or W, it is assumed positive is east of Greenwich and negative is west of Greenwich. The 
International Date Line follows the 180° meridian, making a few jogs to avoid cutting through 
land areas.

LPTS Low Power Time Source

LSB Least Significant Bit or Bytes of a binary word

LTP Local Tangent Plane coordinate system. The coordinates are supplied in a North, East, Down 
sense. The North and East are in degrees or radians, and Down is height below WGS-84 ellipsoid 
in meters.

m/s Meters per second (unit of velocity)

m/s/s or m/s2 Meters per second per second (unit of acceleration)

m/s/s/s or m/s3 Meters per second per second per second (unit of impulse or “jerk”)

Mask Angle The minimum GPS satellite elevation angle at which a satellite is used in a navigation solution.

MID Message Identifier. In case of SiRF protocol, it is a number between 1 and 256.

MIPS Million Instructions Per Second

MHz Megahertz, a unit of frequency equal to one million Hz

MSB Most Significant Bit or Byte within a binary word or a byte

MSL Mean Sea Level

MTBF Mean Time Between Failure

MUL Memory Upper Lower

Multipath Error GPS positioning errors caused by the interaction of the GPS satellite signal and its reflections.

mV Millivolt

mW Milliwatt

NED North, East, Down coordinate system. See LTP.

NF Noise Factor

NMEA National Marine Electronic Association. Also commonly used to refer to Standard for Interfacing 
Marine Electronic Devices.
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NVRAM Non-volatile RAM Memory that is powered by a backup battery power supply when prime power 
is removed. It is used to preserve important data and allow faster entry to the Navigation Mode 
when prime power is restored. All the SRAM is copied to memory that is preserved by the backup 
battery power supply (sometimes also referred to as “keep-alive” SRAM).

Obscuration Term used to describe periods of time during which a GPS receiver’s line-of-sight to GPS 
satellites is blocked by natural or man-made objects.

OEM Original Equipment Manufacturer

Overdetermined Solution The solution of a system of equations containing more equations than unknowns. The GPS 
receiver computes, when possible, an overdetermined solution using the measurements from five 
GPS satellites, instead of the four necessary for a three-dimensional position solution.

P-Code Precision Code. A spread spectrum direct sequence code that is used primarily by military GPS 
receivers to determine the range to the transmitting GPS satellite.

Parallel Receiver A GPS receiver that monitors four or more satellites simultaneously. SiRF receivers can 
simultaneously monitor 12 or more satellites due to the capabilities of the SiRF chipset it uses.

PDOP Position Dilution of Precision. A measure of how much the error in the three-dimensional position 
estimate produced from satellite range measurements is amplified by a poor satellite geometry 
with respect to the receiver antenna.

Pi The mathematical constant having a value of approximately 3.14159

P-P Peak to Peak

PPS Precise Positioning Service. The GPS positioning, velocity, and time service that are available on 
a continuous, worldwide basis to users authorized by the DoD.

PRN Pseudorandom Number. The identity of the GPS satellites as determined by a GPS receiver. 
Because all GPS satellites must transmit on the same frequency, they are distinguished by their 
pseudorandom number codes.

Pseudorange The calculated range from the GPS receiver to the satellite, which is determined by measuring the 
phrase shift of the PRN code received from the satellite with internally generated PRN code from 
the receiver. Because of atmospheric and timing effects, this time is not exact. Therefore, it is 
called a pseudorange instead of a true range.

PVT Position, Velocity, and Time

RAM Random Access Memory

Receiver Channels A GPS receiver specification that indicates the number of independent hardware signal processing 
channels or unique tracking resources included in the receiver design.

RF Radio Frequency

RFI Radio Frequency Interference

ROM Read Only Memory

RTC real-time Clock

RTCA Radio Technical Commission of Aeronautics

RTCM Radio Technical Commission for Maritime Services. Also commonly used as a reference to the 
standard format that DGPS corrections data is distributed in RTCM Recommended Standard for 
Differential Navstar GPS Service.

SA Selective Availability. The method used by the DoD to control access to the full accuracy 
achievable with the C/A code. (This method is no longer used.)

Satellite Elevation The angle of the satellite above the horizon
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SEP Spherical Error Probable. The radius of a sphere, centered at the user’s true location, that contain 
50 percent of the individual 3-D position measurements made using a particular navigation 
system.

Sequential Receiver A GPS receiver in which the number of satellite signals to be tracked exceeds the number of 
available hardware channels. Sequential receivers periodically reassign hardware channels to 
particular satellite signals in a predetermined sequence.

SNR Signal-to-Noise Ratio, often expressed in decibels.

SPI Serial Peripheral Interface

SPS Standard Positioning Service. A position service available to all GPS users on a continuous, 
worldwide basis with no direct charge. SPS uses the C/A code to provide a minimum dynamic and 
static positioning capability.

SRAM Static Random Access Memory. In context of this document, see also NVRAM.

SSP Synchronous Serial Port

SV Satellite Vehicle

TDOP Time Dilution of Precision. A measure of how much the geometry of the satellites affects the time 
estimate computed from the satellite range measurements.

3-D Coverage The number of hours-per-day with four or more satellites visible. Four visible satellites are 
required to determine a three-dimensional position.

3-D Navigation Navigation Mode in which altitude and horizontal position are determined from satellite range 
measurements.

TTFF Time To First Fix. The actual time required by a GPS receiver to achieve a position solution. This 
specification varies with the operating state of the receiver, the length of time since the last 
position fix, the location of the last fix, and the specific receiver design. See also Hot Start, Warm 
Start, and Cold Start mode descriptions.

2-D Coverage The number of hours-per-day with three or more satellites visible. Three visible satellites can be 
used to determine location if the GPS receiver is designed to accept an external altitude input 
(Altitude Hold).

2-D Navigation Navigation Mode in which a fixed value of altitude is used for one or more position calculations 
while horizontal (2-D) position can vary freely based on satellite range measurements.

UART Universal Asynchronous Receiver/Transmitter. A device that produces an electrical signal and 
timing for transmission of data over a communications path, and circuitry for detection and 
capture of such data transmitted from another UART.

UDRE User Differential Range Error. A one sigma estimate of the pseudorange measurement error due to 
ambient noise and residual multipath.

UERE User Equivalent Range Error. A measure of the error pseudorange measurements due to GPS 
system errors.

Update Rate The GPS receiver specification that indicates the solution rate provided by the receiver when 
operating normally. It is typically once per second.

UTC Universal Coordinated Time. This time system uses the second defined true angular rotation of the 
Earth measured as if the Earth rotated about its Conventional Terrestrial Pole. However, UTC is 
only adjusted in increments of one second. The time zone of UTC is that of Greenwich Mean 
Time (GMT).

VCO Voltage Controlled Oscillator
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VDOP Vertical Dilution of Precision. A measure of how much the geometry of the satellites affects the 
position estimate (computed from the satellite range measurements) in the vertical (perpendicular 
to the plane of the user) direction.

VSWR Voltage Standing Wave Ratio 

Warm Start Start mode of the GPS receiver when current position, clock offset, and approximate GPS time are 
input by the user. Ephemeris data is not available.

WGS-84 World Geodetic System (1984). A mathematical ellipsoid designed to fit the shape of the entire 
Earth. It is often used as a reference on a worldwide basis, while other ellipsoids are used locally 
to provide a better fit to Earth in a local region. GPS uses the center of the WGS-84 ellipsoid as 
the center of the GPS ECEF reference frame.
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